Directorate of Systems
Central Board of Direct Taxes
Income Tax Department

Systems Handbook of
Frequently Asked Questions (FAQS)

May 2013






Systems Handbook of Frequently Asked Questions (FAQs) May 2013

Contents
B O EW O . 3
N O SO PUPPR SRR 3
N ) PSRRI 9
CPC BANGAIOIE ettt 15
Interactive Voice Response System (IVRS)......oouuuiiiiiiiiiiiie e 15
Receipt & Validation of ITRV ..o e e aeee e 18
Processing of INcome-tax RETUIN .........viiiiiiiiiie e 20
Online RecHiCOtioON PrOCESS ... ..etiiieeiiiiiiiiee ettt e e e e e e e e e e 21
Refund & REfUNA RE-ISSUE ...ceiiiiiiiiiiiiiiie et e e 27
Communications sent by CPC........cooiiiiiiiiiiiiee e e e e e e e eeeaaes 31
Notices UNder SECHON 245 ... ..coiiiiiiiiee et 36
Arrear Demand Portal ..........coiiiiiiii e 36
€-TDS APPIICOTION ..ttt ettt 53
e Ta T I | USSR 57
[ (o) (g 1= TP PPP PRSPPI 59
Record Management System (RMS) ........oouuiiiiiiiiiiiieee et 63
Sevottam and Aayakar Seva Kendra (ASK) .........oviiiiiiiiiiieeee e 67
Aayakar SampPark Kendrai..........uuuiieeieeeeee e 71
RSA TOKENS ...ttt ettt e e e ettt e e e e e ettt e e e e e e et eeeeas 75
DESKIOPS & LOPTOPS -t e e 77
Facility Management Services (FMS)..... ... e 79
Website & OFICial @-Mail ... .. s 81

Directorate of Systems, Income Tax Department Page 1



Systems Handbook of Frequently Asked Questions (FAQs) May 2013

Page 2 Directorate of Systems, Income Tax Department



Systems Handbook of Frequently Asked Questions (FAQs) May 2013

Foreword

We are changing the Income Tax world with technology. Many people see technology as the
problem; but we would like to see it as the solution, as the enabler. With the focus on technology-
driven tax administration, the Department is now able to improve the delivery of its public
services, offer multiple channels of communication, individually tailored services, stronger local

accountability and greater efficiency.

During the recent interactions in the Zonal Conferences, it was seen that while working on the ITD
applications, our officers often have many doubts and questions- which require immediate
solutions and answers. There is a need to assist the field formations in addressing these, to
enable them to take full benefit of the computerization efforts of the Department. It is in this
context that the Directorate General of Systems has brought out this booklet titled “Systems
Handbook of Frequently Asked Questions (FAQs)”, as a single reference guide to the common

problems faced by our field officers.

| am very happy to see the efforts put in by the officers of the Directorate General of Systems to
provide the answers to the issues raised by field officers, in this book. | congratulate the
Directorate General of Systems in bringing out this book, which would go a long way in helping

all officers in their day-to-day functioning.

(Dr. Sudha Sharma)
Member (L&C), CBDT
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PAN

Q 1. What action is to be taken when a PAN transfer request is entered by destination AO?

Destination AO enters PAN transfer request for action of source AO in whose jurisdiction PAN is
presently lying. Source AO has to either allow or disallow the transfer request. If transfer request
is allowed by the source AO, the request reaches to Source Range Incharge (in case PAN is under
transfer within CIT charge) or Source CIT (in case PAN is under transfer across CIT charge / RCC)
for their confirmation or otherwise, as the case may be.

Unless source officer takes timely decision on PAN transfer request entered by the destination AO,
PAN will remain stuck up in transfer process.

The relevant instructions are AlS Instruction No. 49 & 53 which are available on ITAXNET through
link Resources->Downloads->DIT_SYSTEMS->AIS Instructions.
Q 2. Why PAN is stuck up in transfer process on account of validation failure?

Prescribed validations are checked by the system during execution of PAN transfer order.
Validations are imposed during PAN transfer process for security reasons so that no fraud could
happen after the PAN transfer.

If validations are successfully passed then PAN gets transferred. If validations fail then PAN does
not get transferred and appropriate error message is thrown. Source AO has to take appropriate
action according to Error message shown. After taking necessary action when transfer order is
executed again then PAN gets transferred to desired destination. Validation failure can be
relating to either AST application or AIS application.

Validation failures relating to AST are:
e Approval for Refund caging is pending.
e Rectification return is under processing.
e Return is under processing.
e Scrutiny proceedings are in progress
e Refund printing is pending etc.
Source AO has to take necessary action to complete the AST processing as shown in Error details.
Validation failures relating to AlS are:
e PAN is under de-duplication process.
e PAN is under core-updation process.
¢ PAN is already in transit.
e PAN is event marked as ‘Fake’.
The issues can be resolved as under:

e In case PAN is under de-duplication process then the source AO/RCC has to first
complete the de-duplication process.
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e In case PAN is under core-updation process then RCC has to first clear the PAN under
core-updation process.

e In case PAN is already in transit then RCC has to remove the PAN from duplicate PAN
transfer order list.

e PAN, marked as Fake, is not transferred.

If there is any issue relating to de-duplication process of a particular group of PANs then the AO
has to note down such PANs which have been grouped together for this purpose and “D-mark”
them. D-marking will remove the PANs from de-duplication list.

Subsequent to the above D-marking, the AO has to take fresh action for transfer of PANs with
similar details (allotted to same person) so that all such PANs are available in his jurisdiction as a
group. After this, the AO should enter PAN(s) for deletion/de-activation through AIS application.

Q 3. How to manage request of restoration of deleted / de-activated PAN?

Ans.  On receipt of request for restoration of PAN from an assessee whose PAN has been
deleted / de-activated against his other retained PAN, the :-

» AO has to initiate Restoration process of deleted/de-activated PAN as per procedure
defined in AIS Instruction No. 73 available on ITAXNET through link Resources-
>Downloads->DIT_SYSTEMS->AIS Instructions.

» Range head has to confirm the process initiated by the AO.
» RCC has to execute Restoration of PAN.

A co-Desk complaint may be lodged by AO / Range head / RCC if any difficulty is faced in
implementation of above process.

Q4. How to resolve cases of One PAN allotted to two persons?
Ans.  Under this category, cases may be of following type :-
(i) Existing PAN has been allotted subsequently to some other person as well by RCC -

These type of grievances can be handled by respective RCCs. Details of processing in respect of a
PAN found issued to two persons may be known from “Query on PANs allotted through Batch”
screen. The AIS audit log may be obtained from the system and a proper analysis carried out to
know which person has been allotted the original PAN and which person has been allotted the
same PAN at a later stage. The PAN belongs to the person who has been allotted PAN earlier in
time. Giving proper facts, Service providers UTIITSL/NSDL may be instructed to issue new PAN to
the person to whom PAN was issued inadvertently at the later stage. RCC is to issue instruction to
service provider to get back wrongly issued PAN card as well.

(i) PANis allotted to some other person by changing core-field data —

In some cases, core field data in AlS database, such as name of the PAN holder, father’s name
(in case of individual) and date of birth or Date of incorporation has been altogether replaced by
Assessing Officers on system using their power to correct genuine mistakes/errors etc. These
cases generally belong to the period prior to Jan. 2005. These changes, made by the AO, are at
times malafide and in violation of the existing instructions, as identity of an existing PAN-holder
stand substituted with that of an altogether different person.
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Subsequently, a facility was provided vide AlS instruction no. 57 which is available on ITAXNET
through link Resources->Downloads->DIT _SYSTEMS->AIS Instructions to restore PAN data
where incorrect changes were made. Through this facility, Assessing Officers are able to undo
changes found to have been done wrongly, during the period 01-06-2003 to 15-01-2005.

This facility is available through screen AIS->Maintenance->Undo Wrongly done changes.
When this facility is run, it shows all changes in the core field data of a PAN, in the reverse
chronological order for the above period.

If RCC observes any difficulty in resolving the case of one PAN allotted to two persons then the
Directorate may be consulted for proper resolution.

Q5. What is the action to be taken on mismatch of Gender (Male-Female) and Title mismatch
(Shri, Smt, Kumari)?2

Ans. There may be cases in PAN database where Gender and title mismatch exist. Where
Gender is of Male and Title is of Female or vice-versa, AO has been given the functionality to
rectify the problem by changing the data through AIS application by taking path AlS-
>Maintenance->Assessee Details + PAN.

However, an application for change in PAN data has to be filed before PAN service provider
where Gender and Title, both are wrongly entered in PAN database. For example Gender is
‘Male’ and Title is ‘Shri’ for a female PAN applicant.

Q 6. s Event Marking in AlS application essential?

Ans. All Events like Death, Amalgamation, Acquisition, Merger, Dissolution, Liquidation, Under
Liquidation, Split and Partition etc. have to be compulsorily recorded in system by Assessing
Officer through AIS application to keep Income Tax PAN Database updated.
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AST

Q 1. How to issue Refund to Legal Heir?

Ans.  For issuing refund to legal heir, the refund status has to be in Unpaid status i.e. first the
refund has to be issued in favor of deceased person. Thereafter, it will be eligible for issuing in
favor of legal heir. For AST generated Refunds, Refund can be issued to legal heir through AST--

>QOTHERS-->REFUND RELEASE TO LEGAL HEIR>FOR AST GENERATED REFUNDS by entering
the required details of legal heir and then taking approval for the same from Range.

For CPC generated Refunds, Firstly, CPC sends details to AO. The AO has to enter the legal heir
information through AST-->OTHERS-->REFUND RELEASE TO LEGAL HEIR>FOR CPC
GENERATED REFUNDS. Thereafter CPC issues the refund to legal heir.

Please refer attached user manual for details.

Q 2. How to issue the refunds blocked by DIT(S)-l1I2

Ans.  The refunds are blocked by DIT(S)-Ill in the following situations.
TDS credit to be validated

Extra Credit of challan

Suspected Refund case

For unblocking of such refunds are requests have to be submitted to DIT(S)-lll, the procedure and
proforma of which is given in AST Instruction No. 99.

Q 3. How to issue the refunds blocked by OLTAS?

Ans.  In case a refund is sent as unpaid by Bank with reason code 15 (Cheque Refused), 16
(No such Address) or 17 (No such person) then the refund is blocked by OLTAS.

These refunds can be retransmitted only after the necessary action is taken by AO for unblocking
this refund. These Refunds can be unblocked in the system though AST-->Processing-->
Approval workflow---> Refund unblocking--->Refunds blocked by OLTAS--->Send request to
unblock refund and approval has to be taken for the same from Range. After it is unblocked, the
refund can be issued to the assessee.

Q 4. What is the procedure of caging of refunds?

Ans.  Refunds can be caged in the system through AST->Others>Refund Caging. For high
value refunds (equal or more than 1 lakh) , approval has to be taken for Refund Caging from
Range through AST->Processing=>Approval Workflow—>Refund Caging Approval.

Please refer to AST instruction no 104 also.
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Q 5. Whether the TDS claimed in the return of income can be increased u/s 1542

Ans.  TDS amount can be increased u/s 154 by sending TDS approval request with updated
TDS amount. A new screen will be opened during computation as “Claimed TDS correction”. In
that screen user needs to enter correct TDS amount in “Correct TDS claim as per return” field and
click on submit button. This TDS approval request will be raised to Range.TDS approval request
can be approved only once and TDS approval request cannot be resend once accepted. It cannot
be cancelled after accepted by Range. This is a one time facility , hence should be utilized very
carefully.

Q 6. The refund is shown as ‘Paid’ in AST. Whether it has actually been paid?

Ans.  Those Refunds which have been paid through Refund banker, ‘Paid’ status in BCP means
it is actually PAID to the assessee.

Those Refunds which were sent to the assessee through refund vouchers, ‘Paid’ status in BCP is
shown as and when refund is printed through System. It does not necessarily mean it is PAID to
the assessee. To verify whether it has been Paid or not, its data needs to be checked in OLTAS
through OLTAS-->QUERIES-->OLTAS INSTRUCTION-31-->REFUND DETAILS.

Q7. Whether PAN migration can be denied, if the case has been selected for scrutiny?

Ans.  PAN migration is not denied if the case has been selected for scrutiny. But if the scrutiny
proceedings are initiated in the System, then PAN cannot be migrated. In this situation user
either needs to delete the initiation or complete the proceedings for enabling migration of PAN.

Q 8. How does the AO give effect to the order of CIT (A)?
Ans.  In ITD application give effect can be given in two ways:-
Give effect to other orders: In this AO can give effect to any order present in the system.

For such cases, AO can go through ITD>AST->Give Effect>Give Effect to other orders and save
the details for PAN and assessment year and complete the proceedings

Give effect to Order: Once CIT(A) has entered the details for give effect then jurisdictional CIT
needs to acknowledge the same by entering Date Of Receiving through ITD>AST->Give
Effect>Orders Received. After the date is entered AO can go through ITD>AST>Give Effect>
Give Effect to Orders and enter the details for PAN to complete the proceedings.

Q9. How does the AO give effect to the order of Settlement Commission?

Ans.  Through CIT/Range login user needs to go to ITD>AST->Appeal>Linked/Unlinked
Other Appeals, select Settlement Commission from LOV, enter the details and save. Then through

CIT login go to ITD>AST>Give Effect>Orders Received and enter the date of receiving for
Settlement Commission. After then user can go to ITD>AST-> Give Effect and enter the details
for PAN and assessment year to complete the proceedings.

Q 10. While passing a rectification order on the System, AO sees a messages “Sum of refund in
OLTAS is more than the refund available in AST”. What should AO do?

Ans.  The reason for such a message is that sum of refund amount existing in OLTAS is greater
than the refunds appearing in AST for a particular PAN & AY. In this connection, OLTAS team has
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circulated details of issuing bank details to respective CsIT for verification to be carried out at the
level of AO in coordination with concerned bank/branch.

On verification AO shall discover the following two scenarios :
1) AO Accepts issuance of Manual refund

Action: - Functionality will be provided in AST to take cognizance of issued manual refund
in Ledger

2) The AO Finds that either PAN or A.Y. or both are incorrect or no such refund has been
issued .

Action: - Screen will be provided in OLTAS to provide the bank details. The AO can verify
the facts from the banks and take suitable action.
Q 11. How can the AO correct the AY/Major Head/ Minor Head in challan?

Ans.  For changing of the AY/Major head/Minor Head challan POST flag must ‘R’ (Ready to
post) and Consumed flag must be NULL

To change the asst year/minor head of this challan follow these steps:
e Login to PDC. Navigate to OLTAS-> Maintain Challan-> Challan Details.
e Select "Valid data requiring some correction by AO" option and query for the challan.

e Press the ‘Correct records’ button and make the required corrections in asst yr/minor
head, enter remarks and save the record.

To change the PAN of the challan follow these steps:
e Go to OLTAS->Maintain Challan-> Challan Details.
e Enter the CIN select ‘All’ option and query for the desired challan.
e Enter valid PAN in TAN/PAN' and enter remarks and save.

Q 12. How can AO upload assessment orders manually passed earlier on the AST System?2

Ans.  In AST there is provision of uploading the manually completed scrutiny cases into the
system. The AO can upload the order only if the date of order pass is before 60 days from the
current date (this is applicable for cases for assessment year greater than or equals to 2010).If
the difference between the date of order pass and current date is more than 60 days ,the system
would not allow the AO to upload the order in AST. For the cases where assessment year is less
than 2010 (Older than 2010) there is no time limit for the uploading of order in AST.

For uploading order the AO will follow the following path:

AST->ASMT->ASSESSMENT PROCEEDINGS->UPLOAD PREVIOUS ASSESSMENT ORDERS->AO
will query the pan and assessment year -> Then initiate the proceedings -> Enter the date of
order passed(date in which the scrutiny case was completed manually)->click on adjustment
demand and complete the proceedings

Q 13. How can AO re-issue the refund which was not paid to assessee?

Ans.  These Refunds can be reissued to the assessee by cancelling the existing cheque details in
the system through AST->Others=>Cancel Cheque and approval needs to be taken for cheque
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cancellation from higher authority. After the cheque has been cancelled, the refund can be
reissued to the assessee through the system.

Q 14. How can AO request CPC to transfer rectification rights?
Ans.  User needs to follow below mentioned Navigation Path- AST-->Processing->CPC
Interface-->Request CPC to transfer Rectification rights to AO. Enter pan, year and other details.

Q 15. In case AO has processed a return by entering wrong AY. What is the remedy?

Ans.  If the return is already processed then AY cannot be changed.

The only remedy in the system is to rectify the wrong assessment by using functionalities made for
invoking section 154. There could be two scenarios

a. There is no original return for the AY. In such a scenario, the 154 will be carried out to nullify
the entire data of return including demand, if any. If any refund is issued, a demand notice will
have to be issued to recover the same. If the same case has already been selected for scrutiny by
process of CASS, the same will have to be filed by AO. The actual return, when being processed,
will be entered as revised return.

b. There was a original return for the AY but AO has over-written the data while processing. In
such a scenario, the 154 will be carried out to restore data of original return and any demand/
refund will be re-issued as per changed scenario.

If the same case has already been selected for scrutiny by process of CASS, the same will have to
be considered by AO.

If, in the meantime, case gets time barred, AO has to use functionality provided for invoking
section 119(2).

But if return is unprocessed and it is a paper return and it is not selected in scrutiny then return
entry can be deleted and details can be entered again with correct AY.

Q 16. The AO has processed a return by entering wrong PAN. Can it be corrected?

Ans.  If the return is processed then PAN cannot be changed.

The only remedy in the system is to rectify the wrong assessment by using functionalities made for
invoking section 154. There could be two scenarios

a. There is no original return for that PAN for given AY. In such a scenario, the 154 will be
carried out to nullify the entire data of return including demand, if any. If any refund is issued, a
demand notice will have to be issued to recover the same. If the same case has already been
selected for scrutiny by process of CASS, the same will have to be filed by AO. The actual return,
when being processed, will be entered as revised return.

b. There was a original return for that PAN for that AY but AO has over-written the data while
processing. In such a scenario, the 154 will be carried out to restore data of original return and
any demand/ refund will be re-issued as per changed scenario.

If the same case has already been selected for scrutiny by process of CASS, the same will have to

be considered by AO.
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If, in the meantime, case gets time barred, AO has to use functionality provided for invoking
section 119(2).

There is a possibility of change of jurisdiction in the meantime, in which case each AO will be

handling their own case ie 154 will be done by one AO and processing of original reurn will be
done by other AO.

But if return is unprocessed and it is a paper return and it is not selected in scrutiny then return
entry can be deleted and details can be entered again with correct AY.

Q 17. What is the path in ITD application to find out IRLA demands which are yet to be
uploaded on CPC portal?

Ans.  Report can be generated through following navigation path
ITD->IRL->Reports>Contemporary and Current position of IRLA Demand

User need to select option “Yet to be uploaded on CPC Portal” to generate the report. Report is
generated in .CSV format.

Q 18. What types of demands are required to be uploaded on CPC Portal?

Ans.  As per instruction# 82 issued by DIT(S), user need to upload demands on CPC Portal in
case of following scenarios

a) IRLA Demands generated prior 1.4.2010
b) Manual/TMS demands

Q 19. What types of demands are not required to be uploaded on CPC Portal?

Ans.  User does not need to upload demands on CPC Portal in case of following scenarios
a) IRLA Demands generated after 1.4.2010
b) IRLA Demands prior 1.4.2010 if subsequent order has been passed after 1.4.2010

Q 20. How does user know about latest position of demand uploaded on CPC Portal?

Ans.  User can navigate following path in ITD

ITD>AST->Processing=>CPC Interface-> Status of Demand Uploaded by AO on CPC Portal

The data is being shown on this screen as per dump received by CPC on quarterly basis.

Q 21. What is the provision to NULLIFY any demand on CPC Portal in case orders has been
rectified?

Ans.  If user is passing rectification order in AST then he/she can give DIN reference of demand
uploaded on CPC portal and then same DIN will be shared with CPC as a previous DIN resulting
nullifying of previous demand uploaded on CPC Portal.

If user is passing rectification order out of system then demand can be nullified after
downloading-correction-uploading of xml file on CPC Portal.
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Q 22.

Ans:

Can AO view the return filed through e-filing?

Yes. The AO can view the e-return in the following path.

AST>Report>MIS report --> Total e-file return on web server. Further, Form view of e-filed
returns along with all the detailed schedules is also available through the AO e-filing portal.

Following are the frequently occurring PRs in AST—

1)

If assessee furnished one paper return as Original (processed/unprocessed) and also filed
one return electronically through E-filing system then both return will be marked as
Original in system. AO has provision to mark one return as Revised in case other return is
“In time” or mark one return as “Invalid” if other return is “Belated”. Return may be
marked as invalid through ITD>AST-> Others>Mark Defective Screen.

If any proceeding is initiated in the system and user tries to initiate any other proceeding
then error occurs as ‘Previous un-posted application present’. In such case user either
needs to delete or complete the first initiation.

User is unable to see the return in AST through assessee has e-filed the same. In such
cases following may be the possibility- ITRV is not received by CPC therefore return is not
transferred to AST yet.

On entering TDS details, unique constraint error comes. In such cases one more return is
also filed for that particular PAN and assessment year in some other RCC. To proceed
further user needs to get the previous entered return deleted.

On saving the return user gets the error that ‘Return is with CPC’. In such cases return is
in processing with CPC. Once processing is completed then processed data will be
transferred to AST and user will be able to proceed further.

While adjusting the refund, user gets PAYO1 error. In such cases PAYO1 parameter is not
set for that particular user. The user needs to contact AST Admin to set PAYO1 parameter
for him.

While processing the return user gets error ‘Return already exists in TMS'. In such cases
return already present in TMS. If return is unprocessed then return from TMS can be
deleted. And if return is processed in TMS then the same cannot be processed in AST.
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CPC Bangalore

Interactive Voice Response System (IVRS)

Q 1. What is the number to contact the CPC call centre?

Ans. The number is 18004252229 (Toll Free — India) and 080 22546500 (Toll No India &
Abroad)

Q 2. What are the working hours during which CPC call center can be contacted?
Ans. 8:00 A.M to 8:00 P.M Monday to Friday. IVRS is available 24/7.

Q 3. What is the first option available on the IVR2

Ans. The first option available is to select the language preference.

Q 4. The service is available in how many languages.
Ans. Service is available in 3 languages. English, Hindi and Kannada
Q5. What are the options the taxpayer has to select in order to speak in any of the available
languages?
Ans. The tax payer can select any one of the below option to speak in the particular language
e English - option 1
e Hindi — option 2

e Kannada - option 3

Q 6. Which is the option available after language selection in the IVR?

Ans. The next option is to know the pre processing and post processing status of his ITRV.

Q7. What are the various status update that we can get for an ITRV2
Ans. The tax payer can know the status of the below selection

e |TRV Processing status - option 1

e Refund status - option 2

e Rectification status - option 3

e Talk to an agent - option 9

Q 8. What is basic information required to know the processing status in IVR?
Ans. E - Acknowledgement number followed by DOB/DOI (DD-MM-YYYY)

Q9. What is basic information required to know the refund status in IVR?

Ans. Last numeric digit of the communication reference number followed by
DOB/ DOI (DD-MM-YYYY)
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Q 10. What is basic information required to know the rectification status in IVR?

Ans. Last numeric digit of the communication reference number followed by
DOB/ DOI (DD-MM-YYYY)

Q 11.  What is basic information required to speak to an agent in [VR?

Ans. Four numeric digit of the PAN number followed by DOB/ DOI (DD-MM-YYYY)

Q 12. Is there any option to go back to the previous menu or to speak to an agent after
listening to the processing/refund/rectification status?

Ans. Yes, tax payer can select option 0 to go back to previous menu or 9 to speak to an agent.

Q 13. How is the ticket created for a call if the solution is given and query is resolved?

Ans. The agent would create a L1 ticket on every call received and select status as resolved, if
solution is provided and no escalation is required. The tickets are raised separately for each
different PAN. In case of a subsequent call from the same PAN number, earlier tickets can be
tracked through the TMS (Ticket Management System).

Q 14. If the solution is not provided at first point of contact then what is the procedure to create
a ticket?

Ans. The agent would then create a ticket and assign to L2 group. L2 agents would investigate
the case and update the solution. The L1 agent would inform the taxpayer to call back after 48
hours.

Q 15. Is there any other group to which ticket can be assigned apart from L1 and L22

Ans. Yes. The L2 agent can assign the ticket to the group L3 .These tickets are worked by tax
experts and if they are not able to provide a solution then it is referred to Income Tax Department
Officials. The L1 agent would inform the taxpayer to call back after 5 working days.

Q 16. What are the reasons for the tax payer to be unable to connect to the call center?

Ans. There might be technical issue because of which the tax payer might not be able to connect.
There is also a chance that all the 60 channels are occupied because of which the 61st caller
might not be able to connect, in which case caller has to retry.
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Q 17. What are the different categories on which an agent can give information?

Ans. The agent can provide information on the below categories:

CALL CATEGORY DESCRIPTION

ITR-V Any query pertaining to ITRV receipt status.

Any query/requests pertaining to refund re-issue. Also for

Refund Re-lssue procedure related queries to contact e filing helpdesk

Refund Any query pertaining to first time refund status.
Any query pertaining to Returns filed manually and processed
ITR-P
at CPC.
Demand Any query pertaining to the Demand raised by CPC.
Infimation Any query pertaining to the communications (143 & 154) sent
by CPC.
Others Any General queries.

Online Rectification | Any query related to e-filed rectification.

Manual Rectification | Any query related to Manual rectification filed at CPC.

Any query pertaining to the Returns which were transferred to
Transferred to AST | AST for processing and also the cases were rectification rights
have been transferred to AST

Campaign Any query pertaining to the campaigns sent from CPC.

Any enquiry pertaining to the intimation / campaign resend

Infimation Re-Send requests placed from CS or from website.

Q 18. What is the escalation procedure followed?

Ans. [f the tax payer is unhappy with solution given at the L1 agent level, or wants to speak to the
next level then the call is escalated to a supervisor. If the tax payer wants to escalate it still further
then the call is handled by Team Leader and that is the final level of escalation.
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Receipt & Validation of ITRV

Q 1. What are the points to be noted by the assessee while sending an ITRV to CPC?

Ans. ITR-V is required to be submitted to CPC, by the assessees who upload e-return without
digital signature. The assessee needs to generate a printed copy of the ITRV, sign the ITRV and
make sure the document is of good and readable quality in A4 size paper before sending to
CPC. The original signed copy has to be sent in the address CPC, Post Bag No.1, Electronic City
Post Office, Bangalore 560100. Except the signature, no other details to be written on the printed
ITRV. The ITRV’s should not be stapled or folded. Digitally signed ITRV’s need not be sent to CPC.

Q 2. What is the time frame for sending the ITRV?2
Ans. The assessee can send the ITRV to CPC within 120 days from the date of E-Filing.

Q3. When will the assessee be informed on the receipt of ITRV?2

Ans. Once the ITRV is received and validated in CPC, the assessee would be informed on the
receipt of the same by ways of e-mail and SMS. Status is also available in the E-Filing “My
Account” section.

Q4. When the ITRV has been submitted well within 120 days and however, the assessee still
receives SMS & emails from ITD-CPC asking to submit the ITR-V, should these mails be ignored
or is there anything the assessee needs to do?

Ans. Please do not ignore such reminders. It only means that the ITR-V is either rejected or not
received by CPC yet. Hence the assessee will have to submit the copy of ITR-V once again. In this
scenario, the E-filing status shows “not received”.

Q5. The assessee has been receiving multiple emails & SMS pertaining to non-receipt of ITR-
V. Why does the assessee receive multiple reminders?

Ans. On regular intervals, CPC sends reminders in the form of email & SMS to those assessees
who have filed their ITR-V, but have not sent a valid physical copy to CPC within 120 days of e-
filing. CPC sends up to 3 reminders to the assessees to submit the valid physical copy of ITR-V.

First: E-filing date plus 30 days, second: E-filing date plus 60 days & third: E-filing date plus 90
days. If assessee sends a valid ITR-V physical copy to CPC and the same is accepted, CPC will
cease sending any further reminders.

Q 6. Are any other documents required to be sent along with an ITRV2

Ans. The assessee needs to send only the signed ITRV to CPC. He does not have to send any
annexures or documents along with the ITRV.

Q7. What are the ways by which an ITRV can be sent?

Ans. An ITRV can be sent by ordinary post, speed post or it can be dropped in the drop box
available in CPC.

Q 8. What are the reasons for rejection of an ITRV?

Ans. The reasons for rejection of an ITRV are either due to “Signature Missing” or “Poor Quality”
of the ITRV document.
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Q9. Would the assessee be informed if the ITRV has been rejected?

Ans. Yes, the assessee would be informed by e-mail and SMS when the ITRV is rejected. The
status of rejection would also be updated in the E-Filing “My Account” section.

Q 10. What does the assessee need to do when his ITRV has been rejected?

Ans. The assessee needs to generate another print of “the ITRV, sign the same in original and
send it back to CPC within 120 days from the date of E-Filing.

Q 11. Which e-mail id and mobile no. would be notified for information of ITRV status?

Ans. The assessee would be notified by the e-mail id and mobile number provided during the
time of e- filing the returns.

Q 12. What are the Do's & Don'ts while submitting ITRV's2
Ans. As given below:

e Please use Ink Jet /Laser printer to print the ITR-V Form. Use of Dot Matrix printer
should be avoided.

e The ITR-V Form should be printed only in black ink. Do not use any other ink option to
print ITR-V.

e Ensure that print out is clear and not light print/faded copy.

e Please do not print any water marks on ITR-V. The only permissible watermark is that
of "Income tax Department" which is printed automatically on each ITR V.

e The document that is mailed to CPC should be signed in Original.

e Photocopy of signatures will not be accepted.

e The signatures or any handwritten text should not be written on Bar code.
e Bar code and numbers below barcode should be clearly visible.

e Only A4 size white paper should be used.

¢ Avoid typing anything on the reverse side of the paper.

e Perforated paper or any other size paper should be avoided.

¢ Do not use stapler on ITR-V Acknowledgement.

e In case, you are submitting Original and Revised Income Tax Returns, do not print
them back to back. Use two separate papers for printing ITR-Vs separately.

e Please do not submit any annexures, covering letter, pre stamped envelopes, along
with ITR-V.

e The ITR-V form is required to be sent to Post Bag No.1, Electronic City Post Office,
Bengaluru, Karnataka-560100, by Ordinary or Speed Post (without Acknowledgment)
ONLY

e [TR-Vs that do not conform to the above specifications may get rejected or
acknowledgement of receipt may get delayed.
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Processing of Income-tax Return

Q 1.  Which return will be processed if Original & Revised return are filed on the same date?
Ans. Revised return (since it's the latest return) will be processed if original return and revised
return are filed on the same date.

Q 2. | am a salaried employee and | have filed the original return on 30th July 2012 and ITRV
for the same is not sent to CPC and on 10th August 2012, | have revised the return and sent ITR
V to CPC, which return will be processed at CPC?2

Ans. Return filed on 10th August will be processed as original return, as the ITR V has not been
sent for the return uploaded on 30" July 2012.
Q 3. Which return will be processed if revised return and Rectification are filed on the same

date?

Ans. Revised return will be processed. Rectification application will be rejected.

Q 4. | have received the letter from CPC stating that my return is defective, what do | need to
do?

Ans. The defect mentioned in the communication has to be rectified and a new xml has to be
uploaded with the complete data. (Path: login to www. Incometaxindiaefiling.gov.in)

Q 5. | have received the communication (M1) from CPC stating that there is a TDS mismatch of
Rs 10,000 for the particular TAN, what do | need to do?

Ans. Please liaise with the deductor for correcting the same and after the same is done by the
deductor check the credits in 26AS form.

Q 6. The deductions claimed by me in the return have not been allowed by CPC, what is the
reason and what should be done to rectify it?

Ans. Deductions are allowed on the basis of complete details furnished in the relevant schedules.
Please refer to the intimation order which provides as annexure the complete schedules as
entered by the assessee and as computed by CPC.

Q7. | have received the intimation from CPC wherein the depreciation claim is not allowed
and demand has been raised on me. What do | need to do?

Ans. Please check whether the relevant schedules are filled and in Schedule BP the claim for
depreciation rightly made. If not please file the rectification application duly making the necessary
corrections.

Q8. What needs to do if Processing completed at CPC but details are not visible at AST
system?

Ans. AO needs to raise a ticket in Codesk system and response will be provided with details.

Q9. Under what circumstances return will not be processed at CPC?

Ans. If the return has been selected for scrutiny and the notice u/s 143(2) is issued from AST,
then the return will not be processed in CPC and will be transferred to AST.
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Online Rectification Process

Q 1. Can Tax Payer file for Rectification application through Paper mode?

Ans. Paper Rectifications will be accepted in CPC only for Paper returns the A.Y.2008-09
Processed in CPC. For returns filed electronically and Processed at CPC, the rectification
application should be filed online only.

Q 2. What are Pre-Requisites to file for Rectification request with CPC, Bangalore?

Ans. Pre — Requisites for Filing Rectification are as follows:

e Online Rectification will be considered provided Original Returns filed by the Tax Payer
through Online.

e The Income Tax Return for the Assessment Year should have been processed in CPC,
Bangalore.

e Intimation under Section 143(1) or an order Under Section 154 Passed by CPC,
Bangalore for the E-filed Income Tax Returns should be available with Tax Payer.

Q 3. What are the Steps involved in Filing Online Rectification?
Ans. Following are the Steps involved in Filing Online Rectification:

Step 1: LOGIN to E-Filing Application and GO TO ‘My Account', ‘Rectification Request.'

Step 2: Select the Assessment Year from the drop down for which Online Rectification to
be filed, enter Latest Communication Reference Number (As mentioned in CPC
Order) and latest CPC Order Passed Date (As mentioned in CPC Order).

Step 3: Select the “Rectification Request Type”:

* Tax Payer correcting Data for Tax Credit Mismatch only: Once Tax Payer clicks,
three check boxes TDS, TDS and IT will be displayed. Tax Payer can select the
check box for which the data needs to be corrected. Based on the selection, TDS,
TCS and IT fields are displayed.

* Tax Payer is correcting the data in Rectification: Tax Payer needs to select the
reason for Rectification, Schedules being Changed, Donations and details
regarding Capital Gains if Upload XML.

* No further Data Correction required, Reprocess the Case : Once Tax Payer,
three Check Tax Credit Mismatch, Gender Mismatch, Tax / Interest Mismatch will
be displayed. Select the Check box where Reprocessing is required.

Step 4: Click on “Submit” button.

Step 5: On successful completion, an acknowledgement number got generated and sent
for Processing to CPC, Bangalore.

Q 4. Which CPC Number should | update while filing Online Rectification Request?

Ans. You need to update the Communication Reference Number as per the Latest Order /
Intimation received from CPC Under Section 143(1) or 154.
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Q5. Which Order Passed Date should | update while filing Online Rectification Request?
Ans.  You need to update the Order Passed Date as per the Latest Order / Intimation
received from CPC Under Section 143(1) and 154.
Q 6. | am getting error as “Incorrect details. Please enter details as per Latest Order” while
filing Online Rectification, What should | do?
Ans. This error occurs due to One of the following reasons:

e When you are entering below fields wrongly:

* CPC Communication Reference Number

* CPC Order Passed Date

Ensure that you have updated the above fields correctly as per the CPC Order and also
ensure that you have selected the Proper Assessment Year from the drop down.

e If a subsequent CPC Order exists , you have to file Rectification Request by using latest
CPC Order Passed Date.

For Example: If you have received an Intimation from CPC on 14™ September, 2011 and another
on 11" January, 2012. You can file Rectification Request using the latest CPC Order Passed Date
i.e. 11" January, 2012 for the relevant assessment year.

e If you have filed a Rectification Request for the relevant assessment year and the same has
been rejected by CPC. Now if you are trying to file another rectification Request using the
Old CPC Communication Reference Number, then this error message exists.

Q7. | wantto file an Online Rectification under Section 154 for Tax Credit Mismatch ONLY,
what should | do?

Ans. In this scenario, there is no need to upload XML. Select the User Type as “Tax Payer
correcting data for Tax Credit Mismatch Only” from the drop down and then update proper
details with respect to TDS, TCS and IT. Submit the Request. No XML upload / Submission is
required.

Q 8. | want to file Online Rectification Under Section 154 to correct my data, what should | do?

Ans. In this scenarios, there is a need for a Tax Payer to upload XML. However, as per Provisions
Under Section 154, Tax Payer can file Rectification for correction of mistakes which are apparent
from the record.

Q9. | want to file Online Rectification Under Section 154 for Reprocessing by Income Tax
Return, what should | do?

Ans. In this Scenarios, No XML upload is required. Select the User Type as “No further Data
Correction is required, Reprocess the Case” and then select the respective check box such as Tax
Credit Mismatch, Gender Mismatch OR Tax / Interest Mismatch accordingly.

Q 10. How can | see the “Status of the Rectification Request”?
Ans. LOGIN and GO TO “My Account” and then GO TO “Rectification Status”.
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Q 11. My E-Filed Income Tax Return has been processed by CPC raising a demand OR less
Refund, Whom should | approach for Rectification?

Ans. In case your Income Tax Return for the relevant assessment year is Processed by CPC, then
Assessee can file Rectification with CPC. In case if the Rectification Request has already been
transferred to AST, then Tax Payer has to file Rectification Application on Paper.

In order to know whether rights are with CPC or AO, the Tax Payer should LOGIN and GO TO
“My Account” and then GO TO “My Returns / Forms” and Check the Status.

Q 12. If I have uploaded wrong Rectification Request, what is the Procedure for the Correction?

Ans. You can withdraw the Rectification Application within 7 days from the Date of Filing the
Rectification Request. In order to withdraw the Rectification Application, LOGIN and GO TO “May
Account” and then “Rectification Status”.

Q 13. In case if | have filed Income Tax Return with One ITR, can | rectify the same with different
ITR Form?2

Ans. No, for the purpose of rectification, form type cannot be changed. To change form type,
Assessee has to exercise option of “revision of Return”.

Q 14. The demand raised by CPC has been paid by me, Do | need to file Rectification Request
in order to nullify the Demand?

Ans. No. There is no need for you to file Rectification Request, the demand will be
automatically reduced.

Q 15. For the A.Y.2009 — 10 | have Demand and for the A.Y.2010 — 11 | have arrived ot
Refund and that Refund has got adjusted with the Demand of A.Y.2009 — 10. Demand raised for
the A.Y.2009 — 10 has been already paid off, what should | do in order to get refund which is
wrongly adjusted?

Ans. Apply for Rectification for the A.Y.2009 - 10.

Q 16. How many times can | file Rectification?

Ans. Legally, a return can be rectified any number of times before the expiry of four years from
Original Order Passed Date.

Q 17. Deductions Under Chapter VIA has not been allowed while Processing the Income Tax
Return by CPC?

Ans. Check whether relevant information is furnished by you in Schedule Chapter VIA as well as
in Part BTl at the time of filing Income Tax Return. If Yes, select User type as “No further Data
Correction is required, Reprocess the case”. If No, upload new XML OR amend the latest XML
after verifying the Order Passed by CPC.

Q 18. Deductions under Chapter VIA have not been allowed while processing the Income Tax
Return by CPC as Normal Income not disclosed?

Ans. You have to file Revised Return in case if the Original Return is filed within the due date OR
Time limit to file Revised Return is not exceeded. Rectification is the Process for correcting the
mistakes which is apparent from the Records.
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Q 19. Credit for Tax Payments has not been allowed by CPC at the time of Processing the
Income Tax Return, what should | do?

Ans. First step is to check whether the details mentioned by you in Schedule TDS, TCS OR IT is
correct or not. If Yes, select user type as “No further Data Correction is required, Reprocess the
case”. In No, upload new XML OR amend the latest XML after verifying the Order Passed by CPC.

In case if there is no issue with the Tax Credits in the earlier Income Tax Return, however the
credit was not allowed in the latest Rectification Order Processed by CPC, then verify the Order
passed by CPC and ensure the correctness of the data in the latest XML already processed by the
CPC. If the data mentioned by you is correct, then select user type as “No further Data Correction
is required, Reprocess the case”. If No, then select user type as “Tax Payer correcting the Data for
Tax Credit Mismatch ONLY” and then, enter proper details with respect to Schedule TDS, TCS
and IT.

In case if you have entered the Schedules as per the details available in 26AS and OLTAS,
however the credit is not provided in the Order Processed by CPC due to Credits not available in
CPC and if you have received any Communication from CPC regarding the Transfer of Rights to
AST, then you have to Contact Local AO for the same instead of filing Rectification with CPC.

Q 20. My Gender is not correctly considered in the Order Processed by CPC, what should | do?

Ans. First, verify the Gender in NSDL and in the Latest XML. If the Gender in NSDL is “MALE' then
update the Gender as “FEMALE” in NSDL database before filing Online Rectification Request.
Then select User Type as “No further Data Correction is required, Reprocess the case”.

If the Gender is “FEMALE” in NSDL Database whereas Gender updated by you is “MALE” in the
latest XML, then select User Type “Tax Payer correcting the Data in Rectification” and then correct

the Gender.

Q 21. | have not updated the Status Under the head Personal Information in ITR 5/ incorrectly
updated, what | should | do?

Ans. You have to select User Type “Tax Payer correcting the Data in Rectification” and then
update the Status / correct the Status in XML and ensure there are no other issues in the latest
XML already Processed by CPC.

Q 22. | have not updated the Domestic Flag Under the head Personal Information in ITR 6/
incorrectly updated, what | should | do?

Ans. You have to select User Type “Tax Payer correcting the Data in Rectification” and then
update the Domestic Flag / correct the Domestic Flag in XML and ensure there are no other
issues in the latest XML already Processed by CPC.

Q 23. | have not updated the Residential Status / incorrectly updated, What | should | do?

Ans. You have to select User Type “Tax Payer correcting the Data in Rectification” and then
update the Residential Status / correct the Residential Status in XML and ensure there are no other
issues in the latest XML already Processed by CPC.
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Q 24. My Date of Birth has been wrongly considered in the Order Processed by CPC, What
should | do?

Ans. First verify the Date of Birth in NSDL database as well as in the latest XML uploaded by you.
In case if the Date of Birth entered by you is incorrect, then change the DOB in NSDL database
before filing Online Rectification Request. Then, select User Type “No further Data Correction is
required, Reprocess the Case” and then submit.

In case, if the DOB is correct in NSDL database whereas you have updated incorrect DOB in the
latest XML uploaded by you, then select User Type “Tax Payer correcting the Data in Rectification”
and change the DOB and submit.

Q 25. Credit for Relief Under Section 89,90 and 91 has not been allowed in the Order
Processed by CPC, What should | do?

Ans. Select User Type “No Further Data Correction is required, Reprocess the case” and then
select “Tax / Interest Mismatch Flag” then submit the Request and ensure there are no other
issues in the latest order which was Processed by CPC.

Q 26. Rebate on Agricultural Income has been allowed as lesser as | have mentioned the
Gender as “FEMALE" in the latest XML, however the Gender in NSDL database is “MALE”, What
should | do?

Ans. You are required to Change the Gender as “FEMALE” in NSDL database before filing
Online Rectification Request. Then, select User type as “No further Data Correction is required,
Reprocess the Case” and then select “Status Mismatch” and submit.

Q 27. Interest under Section 234A has been levied in the Order Processed by CPC, even though
| have filed the Return within Due Date, What should | do?

Ans. First verify the Due Date and Date of Filing of the Return in the latest XML. If the Due Date /
Date of Filing of the Return Original / Revised return is incorrect, then select “Tax Payer correcting
the Data in Rectification” then correct Due Date / Date of Filing in the new XML and ensure there
are no other issues in the Order Processed by CPC.

Q 28. Interest under Section 234B has been levied in the Order Processed by CPC, even though
| have paid 90% of the Prepaid Taxes, What should | do?

Ans. First verify Is there is any mismatch in the Tax Credits in the Order Processed by CPC and

also ensure the correctness of data in Schedule TDS, TCS and IT. If Yes, verify the Credits in 26AS
and OLTAS and then select User Type “No further Data Correction is required, Reprocess the
case” and then select “Tax Credit Mismatch” and then Submit.

In case if the details entered by you is incorrect, then select User Type “Tax Payer correcting the
Data in Tax Credit ONLY” then enter details as per 26A / OLTAS and then submit.

Q 29. Interest Under Section 234C has been levied in the Order Processed by CPC, even though
| have paid Advance Tax, What should | do?

Ans. Verify whether the Prepaid Taxes are paid within Due Date. If Yes, select user Type “No
Further Data Correction is required, Reprocess the case” and then Submit.
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Q 30. | have to Change my Heads of Income, Can | Rectification with the Changes?

Ans. Change of Income is not accepted in Rectification, hence you have to file a Revised Return
Provided Original Return is filed within the Due Date OR Time limit to file Revised Return is not
exceeded. Rectification is the Process for correcting the mistakes which is apparent from the
Records.

Q 31. | have not claimed Current Year Losses in the Income Tax Return, can | file Rectification by
claiming Current Year Losses?

Ans. Fresh / additional claim of loss cannot be accepted in Rectification, hence you have to file a
Revised Return Provided Original Return is filed within the Due Date OR Time limit to file Revised
Return is not exceeded.

Q 32. | have not claimed Deductions under Chapter VIA in the Income Tax Return, Can | file
Rectification by claiming Deductions under Chapter VIA?2

Ans. Fresh / additional claim of Deductions Under Chapter VIA cannot be accepted in
Rectification, hence you have to file a Revised Return Provided Original Return is filed within the
Due Date OR Time limit to file Revised Return is not exceeded.

Q 33. | have not claimed Brought Forward Year Losses in the Income Tax Return, Can | file
Rectification by claiming Brought Forward Year Losses?

Ans. Fresh / additional claim of Brought Forward losses cannot be accepted in Rectification,
hence you have to file a Revised Return Provided Original Return is filed within the Due Date OR
Time limit to file Revised Return is not exceeded.

Q 34. | have not claimed Relief Under Section 89,90 and 91 in the Income Tax Return, Can | file
Rectification by claiming Relief Under Section 89,90 and 912

Ans. Fresh/additional claim of Relief Under Section 89,90 and 91 cannot be accepted in
Rectification, hence you have to file a Revised Return Provided Original Return is filed within the
Due Date OR Time limit to file Revised Return is not exceeded.
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Refund & Refund Re-issue

Q 1. What are the modes of giving refund in IT returns filed online?

Ans. Income Tax Department processes the IT returns filed online by the Taxpayer at CPC,
Bangalore, and after processing will result in a Refund (or) Demand (or) NDNR (No Refund No
Demand). If the Taxpayer is entitled for Refund, then he will receive it in either of the following
two 2 modes: Cheque, ECS (Electronic Clearance System)
Q 2. What are all the validations to get the Refund through ECS2
Ans. The validations to get the Refund through ECS are as given below:

1. The Account no. submitted by the Assessee should be valid Account No.

Refund should not be already in Paid or sent status.

3. MICR should be valid and cannot start from 000. This is taken care by existing

validation wherein validity of MICR code is checked for NET REFUND records ( as
provided by the master from Refund Banker Interface team)

4. There should not be any alpha or special character in the account number field. It can
CONTAIN only numbers

Refund amount should be <= 50,000.
6. The assessee may call the CPC Call Centre 18004252229 for the Status of Refunds.

Q 3. What are the necessary validations required in order to get the Refund through cheque?
Ans. The validations to get the Refund through cheque are as given below:

1. Refund Amount should be >= 100. Account Number of length 1 to 17 characters will be
accepted ( both inclusive)

Refund should not be already in Paid or sent status.

3. There should be a minimum of 1 numeric digit (1-9) in the Account Number Implies (
Account number having only alphabets or alphabets and special characters should be

rejected)
If a refund fails ECS validations, then it would be sent through Cheque.

5. The assessee may call the CPC Call Centre 18004252229 for the Status of Refunds.
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Q 4. What should | do, if my Refund is failed due to change in my Communication Address or
change in the A/c details?

Ans. For the change in Address and all address related issues. Taxpayer has to Login to
http://incometaxindiaefiling.gov.in and login to his A\c where in the login id will be his PAN
Number and Password is which is created by him when logging in for the first time.

Taxpayer can make necessary changes and he himself can send a request online hence it will be
processed further. Below are the steps the Tax payer has to follow in order to re-issue his refund
through e filing

e Assessee should first type the PAN no and AY of the Refund failure
e Key in the communication Reference no
e Then the refund sequence number which consists of 10 digits only.

(Note: Assessee can find the communication reference no and refund sequence no
from the communication letter received by the assessee for the failure of his refund)

e And the date of Birth of the assessee

e Then he gets an option to choose if he wants the refund through ECS or PAPER.

Assessee should choose the above option only if the validations mentioned above are
satisfied for ECS and PAPER

e E-fling also gives an option for the assessee to change the Bank A/c no simultaneously
if assessee opts yes

e Then he can update his New bank Ac no with MICR code and also the type of A/c

e Then there is a drop down for the assessee to choose the address where he wants the
refund to be delivered

e The drop gives an option for ITR address, Pan address and New address

e |f assessee selects either ITR or PAN address he will not have to type the address as it
picks the data from the system updated by the assesse at the time of filing

e If assessee selects New address then he will have to update the new address in the
table

e Below are some points to remember while updating the New address in E-filing
0 Mandatory fields like Address 1, State, City , Pin to be updated without fail

0 To enter the address within the given space.

Q5. How to place and refund re-issue request for refunds which have failed for AY 2009 and
later?

Ans. If the refund has failed for AY 2009 and onwards, the assessee can place a refund re-issue
request in two modes:

a) Place a request on e-filing site as follows:

i) Log on to hitps://incometaxindiaefiling.gov.in with your User ID and
Password
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ii) Go to My Account section and select Refund Re-issue Request and enter the
following details:

iii) CPC Reference No. — This is the Communication Reference No. available
on the first page of Intimation u/s 143(1)/Rectification Order u/s 154. This
No. will be of the format CPC/1011/P2/xxxxxxxxxx where xxxxxxxxx
represents a ten digit number .do not use reference number of this letter
as it will not be a valid entry, refer to the order u/s 143(1) or 154 only.

iv) Refund Sequence No. — This number is available in the first page or in the
table Refund Particulars above the Notes, in the above mentioned orders.
It will be a ten digit number like 1234567890

V) Date of Birth — The Date of Birth should be the same as mentioned on your
PAN Card

b) Send a response sheet with the changes required. Assessee can download the
response sheet from the e-filing site or can just send a letter to CPC along with the
details to re-issue his refund.

Mandatory points to be noted while sending a Response Sheet:

% Signature of the Tax Payer on the Response Sheet is Mandatory.

% Original Cancelled Cheque should be enclosed, Photocopied cheque is not
accepted.

% The Original cancelled cheque should have printed or handwritten A/C no on it.
% A/C number and MICR code on the Response Sheet should be as on Cheque.
% Overwritten A/C no and Dual A/C no on the cheque are not accepted.

% Signature on the Response Sheet and the cancelled Cheque should be same.

« Address to be mentioned where the refund to be delivered

Q 6. What steps assessee has to take in case the account no submitted is wrong?

Ans. If the assessee has submitted a wrong account no. and the refund has been paid, the
assesse would have to contact the Refund Banker, SBI, Mumbai, Call center 18004259760, for
getting the refund to the correct account no. In case, the refund is not paid and failed, the
assessee can place a refund re-issue request online, with the new account details for AY 2009
and onwards. For AY 2008, the assessee would have to send a duly filled Response Sheet and
send to CPC along with an Original Cancelled Cheque.

Q7. What steps assessee has to take in case of refunds which have failed due to “Foreign
Address”?

Ans. Where the refunds have failed due to “Foreign Address”, the assessee can place a request
on e-filing site with the new Indian Address as below:

e Log on https://www.incometaxindiaefiling.gov.in with your user id and password
and update your new address in ‘Profile Setting’.

e Go to My Account section and select Refund Re-issue Request

e Re-issue request to a new address/ address as mentioned in your PAN database
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Q 8. What steps Legal Heir has to take to claim the Refund?

Ans. The Legal Heir has to send the request to CPC claiming the Refund. The request will be
accepted at CPC and sent to AO for verification. L1 communication would be sent to Legal Heir
once the request is transferred to AO for verification. Simultaneously, L2 is also sent to the
address of the assessee. AO would verify the necessary documents and update the relevant fields
and send back to CPC. The Refund is processed at CPC and sent to Legal Heir.

Q9. What communication is sent to assessee for refund failures and the remedial actions to be
taken by assessee?
Ans. When a refund is failed, G3 communication is sent to the assessee giving the reasons for
failure of the refund. On receipt of the communication, the assessee can place a request for re-
issue either on e-filing site or send a response sheet to CPC.
Q 10. What are the validations for placing a refund re-issue request on e-filing site?
Ans. While placing the request online, following are the validations:

a. CPC Reference No. - If incorrect reference no is given, the request is rejected

b. Refund Sequence No. — There is no validation at e-filing site but would be rejected at
CPC if the sequence no is incorrect

c. Date of Birth — Request will be rejected in case of incorrect information

Q 11. Is any SMS sent on sending the Refund?
Ans. An SMS is sent fo the assessee once a confirmation is received from Refund Banker on the
receipt of the refund advice.
Q 12. How to check refund status in tin-nsdl site?
Ans. As given below:
a. Log on to http://tin-nsdl.com/
b. Click on “Status of Tax Refunds”
c. Click on “Click to check status of refunds paid”
d. Enter PAN and AY

e. Status of Refund would be displayed on the screen along with the Speed Post
No for tracking if the refund cheque has been dispatched.
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Communications sent by CPC

Q 1. What is the different type of communication letters sent out of CPC?2
Ans. CPC sends communication which can broadly be categorized in two categories
i.  Orders passed by CPC

a. Intimation Orders w.r.t . your income tax return or rectification application filed
with the intent of rectifying any mistake in the Order.

b. Notice u/s 245 giving an opportunity of being heard to the assesse
c. Order issued intimating core defects in the return of Income filed.
d. Notice of Rejection of Rectification Application

ii. Other communications

a. Intimation Letter for Demand Follow-up

b. Intimation Letter for Refund failure

c. Communication confirming receipt of ITR-V

d. Reminder on account of Non-receipt of ITR-V

e. Communication giving details of status of refund

f.  Communication to tax payer intimating transfer of processing/ rectification rights
to field assessing officer.

g. Intimation to tax payer once his Income Tax Return has been taken for Suo Moto
Rectification.

h. Intimation to tax payer detailing tax mis-match in the income tax return filed by
him.

i. Intimation to tax payer confirming the receipt of application for substituting Legal
Heirs name.

Q 2. | have submitted my ITR-V well within 120 days; however, | still receive SMS & emails from
CPC asking me to submit my ITR-V. Should | ignore this email or is there anything | need to do?

Ans. Please do not ignore such reminders. It only means that your ITR-V is either rejected or not
received by CPC yet.

You can check your status of the ITR-V submitted by logging into your Efiling account.
Alternatively, you can also can CPC Customer Service Toll Free number 18004252229 to check
the status.

If you find your ITR-V is not received by CPC yet, please submit the physical copy of ITR-V once
again.

Q 3. | have been receiving multiple emails & SMS pertaining to non-receipt of ITR-V. Why do |
receive multiple reminders?

Ans. On regular intervals, CPC sends reminders in the form of email & SMS to those assessees
who have filed their ITR-V, but have not sent a valid physical copy to CPC within 120 days of
Efiling. CPC sends up to 3 reminders to the assessees to submit the valid physical copy of ITR-V .
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First: Efiling date plus 30 days,
Second: Efiling date plus 60 days
Third: Efiling date plus 90 days.

Occasionally, this communication is also sent as a one-time campaign either notifying on the
extension of the due date (if any) or just a reminder on non-receipt of ITR-V, and this will be sent
outside the 3 reminders as mentioned above.

If assessee sends a valid ITR-V physical copy to CPC and the same is accepted, CPC will cease
sending any further reminders.

Q4. To which email ID & mobile number are communications sent by CPC?

Ans. CPC fetches the email ID & mobile number from the information provided by the assessee
while filing the return. This information is used to send communications letters pertaining to
orders and various other communications

Q5. After the processing of my return is completed in CPC, how will | be notified?

Ans. After the processing of ITR-V is completed in CPC, assessees are intimated with the
communications letters (orders) in the form of

a. Email,
b. SMS (notification only) &

c. Print (for emails which fail / bounced and orders which result in demand)

Q 6. | have not provided a valid email address and / or mobile number while filing my return,
how will | rectify this?

Ans. CPC sends orders and various other communications to the email ID & mobile number
provided in the ITR. If this happens to be an invalid / incorrect or email ID or mobile number
doesn’t exist, then the email and/or SMS would fail; however, if the email ID and/or mobile
number provided by the assessee is valid, but doesn’t belong to the assessee, then all emails &
SMS would still go out to the same email ID & mobile number given in the ITR-V.

In order to update the mobile no. or email ID, assessee will have to login to their Efiling account
and make the necessary corrections, and then place a resend intimation request to get the orders
to the updated email ID.

Alternatively, assessees can call CPC Customer Service Toll free no. 18004252229 and request
for a resend request.

Q7. If my mailbox is full and have not received the intimation by email, how else can | get the
intimation letter?

Ans. If your mailbox is full, you will not receive any email communication from CPC and it would
result in “delivery failure” or “bounced mail”. Under such circumstances, assessees will receive
the orders by print.

For all order us/s 143(1) having outstanding demand, intimation is served to assessees by both
email & print, along with the notification SMS.
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For refund & no demand, no refund cases (NDNR) of orders u/s 143(1), assessees who have
given a valid email ID & mobile number will receive the intimation by email & nofification via
SMS.

For all types of orders u/s 154, intimations are sent by both email & print.

Q 8. What is the procedure to place an intimation resend request?
Ans. There are two ways an assessee can place an intimation resend request —

a. Efiling - Assessee can use the Efiling site to place a resend request.

b. CPC Customer Service - Assessee can call CPC toll free no. 18004252229 and request
for a resend request.

Note: Resend requests can be placed for Income Tax Returns processed out of CPC only.
There is no limit to place a resend request by email; however, an assessee can place a maximum
of 2 times for print intimation (by post).

Through Efiling, an assessee can place intimation requests for orders only; however, CPC
Customer Service team can take resend requests from assessees pertaining to all communications
processed out of CPC.

Q9. | have received the SMS, but have not received my intimation/order by email yet. When
will | receive this?

Ans. If an assessee has not provided a valid email address while filing the ITR-V, the email would
fail (bounce) and the order will be sent by print.

It is recommended that you check your spam/trash mailbox often to check whether the email sent
from CPC is moved to this place. This happens due to company’s or administrator’s setting and if
you have the privilege to add this email to the trusted source, all future communications from
CPC would directly come to your inbox.

You will not be able to see the PDF attachment (communication letter) if you keep the
communication sent by CPC in your Spam/trash mailbox. In order to view the attachment, you
need to move this email to your inbox first and further, add this email ID as a trusted source list to
receive all future communications directly to your inbox.

You can also call CPC Call Center no. 18004252229 for further queries.
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Q 10. | have received following communication, what should be my next course of action?

Ans. As given below:

Nature of
Communication

Next Course of Action

Demand Follow-up
Notice

3.

Verify the demand as per the follow-up notice with the
intimation order you would have received earlier.

Amounts should match, if need further clarification; call up

CPC helpdesk

If satisfied with response, pay the amount.

If not satisfied, you have the option of filing rectification application
seeking rectification of mistake in order passed by CPC.

Notice u/s 245
giving an opportunity
of being heard to the
assesse when refund
due to the assesse is
sought to be
adjusted against any
previous outstanding
demand.

1.

Validate the contents of notice with the intimation Order you
would receive in response your income tax return for the
relevant assessment year; If you do not have copy of your
intimation Order, reach out to your assessing officer, who can
furnish copy of same.

If you are satisfied with the order, give your consent in writing
to your assessing order concurring to this adjustment.

If you are not satisfied with the Order, please file a
rectification application seeking revision of order raising
demand.

Tax Mis-Match
Communication

This communication is issued to tax payer when there is a mis-
match between the tax credits claimed (Tax Deducted at
source or Self-Assessment Tax deposited in bank or Tax
Collected at source) by him & credits available with CPC as
declared by the tax deductor or details received thru the bank.

This mis-match can be on account of mistake committed by
the tax payer while filing income tax return or deductor or
non-filing of TDS return by tax deductor.

If there is typo error made by you while filing your income tax
return, you have the option of filing a revised return or on
receipt of intimation order from CPC, you can also file a
rectification application, seeking rectification of mistake
committed by you.

If there is an error by the deductor, you would need to reach
out to him & request him to file his TDS return, if not already
filed or file a revised return rectifying his mistake.
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Nature of
Communication

Next Course of Action

Order issued
intimating core
defects in the return
of Income filed

1. Orders are issued intimating core defects in the return of
income when the return of income filed by the tax payer has
defects as laid down by the Income Tax Act, 1961.

2. Order requires Tax Payer to file a new Income Tax Return
rectifying the mistakes as detailed in the order, else return of
income filed earlier would be treated as null and void.

4. The new income tax return can be filed using the efiling portal
https://incometaxindiaefiling.gov.in/ and using your login
credentials and validation checks as provided in the order.
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Notices under Section 245

Q 1. What is the further proceeding with the Sec. 245 Notices?

Ans.  Assessee as to Contact Local Authority for further proceedings within due date.

Q 2. Why is demand raised due to tax credit mismatch, even though | have claimed Tax as per
form 16/16A/26AS (AT, SAT, TDS and TCS)?

Ans.  Following could be the reasons
e Tax Deducted amount has not been deposited by the Deductor
e Deducted Tax has been deposited after the return processed by the deductor
e Tax Deposited Partially by the deductor
e Tax Deposited under Wrong PAN by the deductor
e Taxes paid under wrong minor/major head
e Taxes paid for the Incorrect Assessment Year
e Partial Tax Paid/Taxes is not as per Tax claiming / order
e Tax Credit Claimed under incorrect ITR Schedules
e As per Form 26 AS Tax Credit Status shows other than F (Final).
Please revisit Form 26AS and Rectify as per collections by filing Revised/Rectification Return.
For further clarification please call CPC Customer Care No.1800 425 2229
Q 3.2 Assessee is asking Demand Order, he did not have any demand order for the respective
year?

Ans.  For the CPC Demand we are re-sending Demand Order once again, however for the
Demand Pertaining to AO, requesting Assessee to Contact Local AO.

Arrear Demand Portal

Q1. What is Arrear Demand Utility?
Ans.  The excel upload facility to notify any Demand outstanding against the PAN of an
Assessee to the Centralized Processing Center (CPC) of Income Tax Department (ITD),

Bangalore is called Arrear Demand utility.

Q 2. Arrear demand relating to which order passing date should be uploaded in the portal?

Ans.  Arrear demand not already paid/recovered/adjusted related to the order passing date on
or prior to 31/03/2010 can be uploaded in arrear demand portal using excel utility. Arrear
demands which are created after 31/03/2010 on AST shall get reflected into the CPC accounting
system automatically through the CPC-AST interface and the AOs need not upload such demands
through the excel utility. However, demands created by the AOs manually and outside AST for
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example due to processing through TMS, scrutiny assessment completed manually outside the
system etc. shall have to be uploaded to CPC through the excel utility.

Q 3. When can | upload the Arrear Demand details into the Portal (URL below) by using the
utility?

Ans.  As soon as the amount of demand against a PAN is determined as payable and has not
already been paid / recovered / adjusted, the same can be notified to CPC through the Portal
using the utility provided for this purpose. Notification to CPC is to be made only once (provided
the same has been accepted at CPC). If there is any change to the amount of demand, the
procedure as mentioned in the point number 5, Annexure D: “Steps for reversal & changes to
demand already uploaded” is to be followed. Once notified, such arrear demand is adjusted
against a subsequent refund processed at CPC.

Q4. What is the URL for me to login to the Arrear demand utility?

Ans.  The URL of the site is http://cpcsso.incometax.net and can be accessed by all AOs on
TAXNET similar to itaxnet.

Q5. Isthere any limit on the Demand amount to be uploaded?

Ans.  There is no limit for the Demand amount to be uploaded or notified to CPC. However,
Demand would be adjusted by CPC subsequent to its notification and acceptance, only if there is
return processed and a Refund is payable and even here, adjustment can be made only to the
extent of refund.

Q 6. What is the mode of notification on the portal for arrear demand to CPC?

Ans. In the Portal, the AO’s would have to upload the arrear demands using the excel utility
after downloading the same from the CPC portal. The URL of the portal as mentioned earlier is
http://cpcsso.incometax.net. The excel file needs to be imported into XML file and then uploaded.

Q7. What is the Amount to be entered? Should it include the Interest u/s 220(2) calculated fill
date of uploading?

Ans.  The Amount entered under ‘Demand Amount’ should be the exclusive of the interest u/s
220(2) and should only state amount of the demand. The amount under ‘Interest computed u/s
220(2)" should be for Interest u/s 220(2) calculated till the date specified under the column
“Interest calculated date”. Hence, the demand and interest u/s 220(2) are to be entered in
separate columns.

Please note that in case, CPC is adjusting the demand against a refund to be issued, the interest
u/s 220(2) beyond ‘interest calculated date” will be computed at CPC up to the date of such
arrear demand adjustment and recovered, provided the demand against interest is not already
paid.

If, the section code in the relevant column is 220(2) then the amount of demand is
understandably only due to interest u/s 220(2) and, therefore, the amount of demand should be
written in the column “TOT NETPAYBLE” in the manual sheet which is a column for the net
demand amount and the interest u/s 220(2) column “INT220" should be left blank.

Directorate of Systems, Income Tax Department Page 37



Systems Handbook of Frequently Asked Questions (FAQs) May 2013

Q 8. Will every AO have a unique login & password for logging into the portal?

Ans.  Yes. Each AO can have a user-id & password as desired and this would be the same as
the user name & password in the AST system.

Q9. s there a process to hold a Demand at CPC, which is already uploaded and notified to
CPC?

Ans.  No. The system cannot hold a demand as the Refund processing and Arrear Demand
adjustment is automated and cannot be withheld.

Q 10. What are the mandatory fields to be populated while uploading Arrear Demand
information and notifying CPC?

Ans. In the excel utility, the standard excel has the same fields as the ADCR file in AST and the

number of fields is 41. The data from ADCR in AST and the demands in TMS is directly imported
in the standard excel format by the utility. In the manual sheet, the data entry is required to be
made in the excel sheet manually.

The following fields are mandatory in the manual sheet of excel utility (All the mandatory fields
are marked red in the manual sheet).

(1) SL.NO

(2) PAN

(3) Asst Yr (For example 1998-99)

(4) Section

(5) Order date (Important to note that the format of date is yyyy-mm-dd, for example,
2009-03-14)

(6) TOT NETPAYBLE (Which is actually the demand amount excluding the interest u/s
220(2).

(7) INT220 (Interest u/s 220(2), if any)
(8) Source (i.e. Source of data, for example, MNL for Manual, IRLA for AST demands
and TMS for demands due to TMS.)

After merging the three excel sheets and collecting the output in “Arrear Demand” sheet, the
entire data is available in a format fit for creating the XML and uploading to CPC accounting
system. However, there are certain mandatory fields in the “Arrear Demand” sheet format also
which are marked red.

The mandatory fields are as under:
1) PAN

2) Assessment Year

4
5) Section Code

)

3) Schedule Type (It is a derived field depending upon the section)
) Demand Type (It is a derived field depending upon the section)
)
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6) Date of Creation of demand

7) Date of service of demand

8)

9) 220(2) Interest

10) Interest Calculated Date

11) Source of Data( IRLA/TMS/MNL)
12) SL.No ( Serial Number)

Demand amount

Q 11. How do we know if the Demand is adjusted at CPC?

Ans. If the Arrear Demand as notified and accepted is subsequently adjusted at CPC, the
transaction against the PAN will be reflected as a Minor Head 400 challan payment through Tax
Payer Payments (OLTAS) and will be visible in the OLTAS system providing information on the
same.

Q 12. How do | know if Arrear Demand upload has been successful and accepted for
processing / adjustment at CPC?

Ans. In about 1-2 days after uploading the file of Arrear Demand as per steps mentioned in
this document, log into the portal and check in the ‘History’ option for the ‘Number of records
accepted’ and ‘Number of records rejected’ which will provide information on the acceptance or
otherwise of individual records by CPC. Generation of a DIN (Demand Identification Number) by
CPC system is confirmation of acceptance of the Arrear Demand, for any future processing of the
same at CPC. DIN information will be available within the file used for updating the portal, if
accepted and posted at CPC.

Q 13. Is there any demand AO should not upload?

Ans.  Yes, demands that have been stayed or installments have been granted by the AO or any
other higher authority should not be uploaded. This is because the CPC accounting system does
not have information about the stay or installment scheme and any refund would be
automatically used to adjust this demand. This may lead to violation of stay or installment
granted by AO or Higher Authorities. Further, the block assessment demands and wealth tax
demands cannot be uploaded. The utility also does not support the TDS arrears. Demands
without PAN also cannot be uploaded.

Q 14. Is there a time limit for upload?

Ans.  The time limit is as fixed by the CBDT instruction.

Q 15. Will the CPC system adjust the arrear uploaded by AO against refund arising in AST
system?

Ans.  No, The CPC System would ONLY adjust arrears against refunds arising in the CPC since
it does not have any information about refunds arising in AST system.

Q 16. What about adjustment of arrear demand in AST — will that continue?

Ans.  Yes, The AO has to adjust the arrear out of refunds arising in AST system. However, if
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the AO does not deposit the RO and adjustment challan with RBI / SBI and therefore, the
adjustment does not appear as cash collection in OLTAS as Minor Head ‘400’ payment the CPC
system will not be able to reduce / square off the arrear by the extent of the adjustment challan.
Therefore, it is critical for the adjustment RO to be deposited at RBI / SBI with the assessee PAN
and AY mentioned clearly.

Q 17. Can the AO combine arrears of various AYs and upload?
Ans.  No, the AO has to enter separately for each AY and for different types (IT, FBT etc.).

Q 18. Will CPC system compute 220(2) interest for arrear demand from date of demand notice
for each entry?

Ans.  No, it is the responsibility of the AO to compute 220(2) interest till date of upload of
arrear demand or date of calculation of 220 (2) which is specified by AO at the time of upload
whichever is later. The CPC system will calculate 220(2) as per law and various CBDT instructions
only from the date of upload of arrear into the CPC system or date of calculation of 220 (2)
which is specified by AO at the time of upload whichever is later.

Q 19. Will CPC system accept arrear demand without PAN?2
Ans.  No, PAN is a mandatory field. Therefore, it is suggested that the AO should maintain a

Separate record of all such arrear demands where there is no PAN. Such demands should be
collected or reduced by rectification or verification of collection, as the case may be, to slowly
eliminate all such entries. Alternatively, the correct PAN should be identified and then the arrear
record should be updated into the CPC system.

Q 20. Is the CPC arrear accounting system a substitute for the A&DCR and can the manual
A&DCR be done away with?

Ans.  The primary objective of the CPC arrear accounting system is to provide a mechanism to
the AO to intimate the CPC about arrears of any taxpayer mainly for the purpose of adjustment
of such arrears against any refund arising for that taxpayer in CPC in case of processing of any
electronically filed return or a paper return of Karnataka or Goa. The CPC has concurrent
jurisdiction for the purpose of processing of such returns under section 143(1).

Therefore, the CPC arrear accounting system is NOT a substitute for the A&ADCR and the A&DCR
has to be mandatorily maintained and updated each year by the AO as per CBDT instructions.
The CPC arrear accounting system does not contain all the fields /columns of the A&DCR since
as mentioned above the obijective is different. However, the fields uploaded by the AO would be
available in the CPC staging database.

However, the AO can periodically update and reconcile the CPC arrear accounting system with
the manual A&DCR so that an accurate electronic repository of all arrears can be established.
Q 21. Is the CPC arrear accounting system, a substitute for IRLA?

Ans. IRLA is a part of ITD application and has a different purpose. However, if ALL AOs
systematically and accurately transfer ALL arrear entries into CPC arrear accounting system
(subject to the limitations as mentioned in points m) and s) above), then an accurate electronic
repository of all arrears can be established.
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Q 22. What would happen if AO does not upload the arrear demand to CPC at all or within the
time specified?

Ans.  All refunds arising in CPC are automatically issued through the refund banker after a
mandatory hold period of 42 days if the refund amount exceeds Rs 5,000 (or any limit as
specified by CBDT as the maximum refund amount that can be issued without the requirement of
verification of arrear demand). Within this period if any arrear demand for that taxpayer is
uploaded then the refund would be adjusted against the arrear demand. If the arrear demand is
not uploaded to the CPC arrear accounting system within the period of 42 days then it shall be
assumed that there no arrear for that taxpayer and the refund will be issued. However, if the
arrear is uploaded after issue of the refund or after the hold period of 42 days then the arrear
can be adjusted only against any future refund that may be determined at CPC.

Q 23. Will the arrear demand be adjusted if the refund arising for the taxpayer at CPC is below
Rs 5,0002

Ans.  Yes, in case of any refund below Rs 5,000, if any arrear demand is already uploaded in

CPC then the demand would be adjusted against that refund. However, since there is no hold
period for such refunds, in case there is no arrear demand entry in the CPC arrear accounting
system, the refund would be automatically issued without awaiting arrear demand upload by AO.

Q 24. Can the AO modify or reverse the arrear demand uploaded by him?

Ans.  Yes, if the demand has not been adjusted against the refund, the AO may modify/reverse
the amount following the procedure outlined in the point number 5, Annexure D: “Steps for
reversal & changes to demand already uploaded”.

Q 25. Can the AO reduce the arrear demand uploaded by him after adjustment of the demand
against a refund is already executed at CPC?

Ans.  No, at the moment this is not possible, since it involves a complex reversal of accounting
entries, rectification of the order under which refund was issued and also reversal of 220 (2) that
may have been computed at CPC. Since this scenario is very complex, the CPC system would
reject any such reduction of demand that has already been adjusted.

Therefore, the AO has to be extremely careful while determining the final and accurate arrear
demand position for each taxpayer and only thereafter should he upload the arrear demand to

CPC.
Q 26. What is Reason code 20, 21

Ans.  While downloading the file or record, latest record for the corresponding assessment year
should be downloaded, which should not include reason code 20 or 21 for a given case all
the uploaded records are errored out with reason code 20 or 21,no records should be displayed
in the downloaded file for that case.

This should be for both file based downloading and pan record based downloading.

Q 27. What is Open Demand for a PAN (Under Development)?

Ans.  This is a new requirement which is under development. The AO who logs into the Arrear
Demand Portal, they will have a provision to check the outstanding demand (Open Demand) for
a given PAN number based on Assessment Year wise. It has the details like Total Demand
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Identified, RO Adjustments (if any), Applied Collections (if any), Provisional Interest Amount (if
any) and finally Current Balance Due Amount etc.

Q 28. Is it possible to download single data instead of bulk, what is procedure for the same?

Ans.  Once the RO (Range Officer) logs in to the Arrear Demand Portal, that RO will has to click
on submit button to view the AO’s under him.

Area Code Range Code

CHE 255

Choose the AO to uplead:

Choose the File to Upload:

Browse

First > Next>> 1-5 6-6 <<Prev <<Last

Once RO selects a particular AO’s radio button and clicks on File download button, the User can

be navigated to the following screen, where the user can download all the records or a pan wise
record download.

Screen 1 : Download All Records

Demand Arrear File Upload

« home

@ All Records () Particular Record

(Check 'All Records' to Download all the Records, 'Particular
Record' to Download Records of a Particular PAN number)

Download Latest Arrear Demand Records

Screen 2: Particular Record Download
Demand Arrear File Upload

« home

7 All Records @ Particular Record
PAaM Mumber : Submit PAN

[(Check "All Records' to Download all the Records, '"Particular
Record' to Download Records of a Particular PAN number)
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In the above Screen 2, if we give a PAN number and clicks on Submit PAN button, you will get

the details in a link. If you click that link you will get the single record download.

Demand Arrear File Upload

< home
All Records @ Particular Record

PAN Number :  AAAPA1234A BRSNS

[{Check "All Records' to Download all the Records, 'Particular
Record’ to Download Records of a Particular PAN number)

Download Latest Arrear Demand Records

Q 29. What is the frequency of transfer of Data from Efiling Administrator to CPC?

Ans.  Frequency of data transfer from Efiling Administrator to CPC is as under:

Data Frequency
ITR Control data - from efiling for the returns filed Daily
Approved Returns - Processing approval after
TDS/Challan match/mismatch Fortnightly
Original, revised, rectification ITR data Fortnightly
Refund reissue, intimation re-send requests Daily
User profile data Daily

Q 30. What is the frequency of transfer of Data from CPC to e-filing Administrator?

Ans.  Frequency of data transfer from CPC to Efiling Administrator is as under:

Data Frequency
Processing status of ITR(Initiation of 154, declaration of
Defective,  Processing  completion of  Original/
Revised/154, Rejection of 154 request, Transfer of ITR

control to AST ), refund status (all into efiling processing

status) Daily
After processing of ITR, order's Control info goes into

efiling processing status Daily
ITRV rejection/Acceptance into efiling processing status Daily
Acceptance/Rejection of Intimation resend / refund re-

issue requests Daily
Outstanding Demand feed Monthly

Directorate of Systems, Income Tax Department
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OLTAS

Q1. How does an AO claim a challan lying locally (Within RCC)?

Ans. Challan not having valid PAN/TAN is reported as suspense challans. Local suspense challan
or challans with valid TAN/PAN can be claimed by AO. For details please check OLTAS
Instruction No é available at i-taxnet. Please follow the steps given below:

e Login into the OLTAS menu from a user having AR ITOAC role and follow the path:
login to PDC=>OLTAS=> Maintain Challan --> Challan Details

e Give suitable query criteria to fetch Challan.

e Update the TAN/PAN field with a valid TAN/PAN of your jurisdiction.

& S
Action Goit Query Qioek Becord Elald Help Window

e chalian Batalte T —————
| o s8] %) 8 0P| 2| 256l sls] &8

Cluery Criteria “For migrating challans of PANs transferred within RCC, use "Migrate Challan"™
Branch BSR Code (0201410 n‘m] Oltas Challan Deposit Date | 16/06/2008 Oltas Challan Serial No. 4
Major Head |21 ﬂ Minor Head [100 M
TAN/PAN Oltas Challan Deposit Date
Amount |~  ~l| OR Amount | To|
Nodal SeroilDateFrem [0108/2008  Fg (11022009 = All  Suspense | Requiring correction of TAN_PAN
 VWalidate data Requiring some Correction by AQ 7 Invalid data requiring correction by AQIDO
Challan Details Save Data to Excel
Bank Branch Challan  Challan Cheque TAMNFAM  Old TANPAN  MName Address “Migrate
Code Code Senal Mo Deposit Date Cr Date & |'.:'||"J|'I
Asst Major Minor Amount Remarks Dedup  Error To be Fost AD code
Year Head Head Fla: Werified by Flag
iEE | 1410 2| 160672008 [16/06/2008 [AAKPFSO1TE F_ [MIGAR FATIMA RAZZAGQU|E-12 KIRAN RESIDENCYC =
[2008] 21 100 3000 | | [combination of Assessment vear and Mino | Bl e[ w [52 [ a
I [ | | | [ [ -
[ | [ [ | |
I | | | [ | | ,
[ [ [ 0 S [ =
No. of Challans |1 Total Amount 2000 Print Report

e Verification/validation of claimed challan is essential.

Q 2. How does an AO/DO verify a challan claimed by AO locally?

Ans. Local Suspense Challan Verification can be done by DO/AO based on Challan Amount.
DO need to verify challans of amount more than 5 lacs. Local valid PAN/TAN challan verification
is done by AO1 and AO2. Please follow the steps given below:

e Login into the OLTAS menu from a user having AR TAS DO/AR_ITOAC role and follow
the path: Login to PDC=>Processing --> Challan Verification

e Verify the challan or reject the challan . TAN/PAN will be updated in OLTAS only after
getting the verification
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o | L gzl 2eE o(ele e = AEI
BT ORY EXEC LAMIEL uP DO LEFT FRIGHT SAUE CLERR EAIT LIST HEY HELP ADD DEL GEM. FIRST LRST ot CoF? i
Challan Verification
Challan Cid Mame As Changed Changed  Asst. Mew Major Minor  Amount Femarks ACH ACZ DO
Seq. Mo, PANTAN  Specified In PANTAN MName Year Ast. Head Head YVerfn  Verfn  Verfn
Bank Record Yr
1 [AACPI9BSEC [PRERNARAGH [AGYPG275T [MANISH RAMESH | 2006 211|400 1630 [test @i @& &=
16 |AADPD2TET, IMADHUSUDAN |AAZPST458M [PRAVIN GHISULA 2007 21 [100 a11 B [@ [
6 DESOUZALANC |AAAPLA140J |PRAVIN JETHMAL | 1396 21 |400 100000 [TEST Eir @ ]
3 [AGLPR3172 [MADHURI KRIS [AOJPS1145K [MIKHIL ANANTRAI | 2008 21 |400 28 |test Eir @ ]
1 [AGVPST 86 [SAXENAPRADE [AHWPKA2511 [NADEEM DILDAR | 2006 21 [100 5000 [tan_pan changed : Eir @ ]
5 [AAAFPO309E [POWERFLEX I [ARAPLA140J [PRAVIN JETHMAL | 2006 265|300 T166 [TEST RN 5 A 5] [
25 |AAKPPO805F [PATEL MAFATE |AAAFM1588M | NOVELTY STATIC|2008 211|300 2300 [test @i @& ]
3 [AAAFP145T4 [POOJA RUBBE [AACPM4932F [MEENA KASHIPR: | 2004 21 [100 4800 |updatye RN 57 | i 1] ]
57 |ANEPS0038 [PALLAVI SHARY |AAAFC1TS5C | CAM-TEK 2006 21 [100 40000 |changed @i @& ]
1125 A O RAREY AXVPS3T40H [MAHESH KUMAR | 2004 211|200 100000 [AVPS3T40HARVP @i @& @] .
‘ Verification of Globally Claimed Challan I
Q 3. How does an AO claim a challan Globally (Across RCC)?2

Ans.

Global Suspense challan can be claimed by Inspector (upto 1 lac)/AO. Global challan

having valid TAN/PAN can be claimed by AO. Challan deposited in the current financial year
cannot be claimed globally. Depending on challan amount, AO or Range incharge has to verify
that challan. Please go through OLTAS Instruction No 39 for global suspense and OLTAS

Instruction No 40
follow the steps given below:

) the path: ~ Maintain Challan --> Global Challan Claiming
e Give the CIN, major head and amount to fetch Challan.

e Enter New TAN/PAN and save it.

e Verification/validation of claimed is essential.

Directorate of Systems, Income Tax Department
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WliEmingof SlobaleEiallan version 1.1 Released in SEP 200

~ Walid TANIPAN  Suspense
Branch BESR Code |051DDEE [E] Oltas Challan Deposit Date |15f1 242007 Oltas Challan Serial No. I 15010

Major Head |21 @l Amount |275DDD

Global Challan's Detail

ITC Application Warning
. & This PAN belongs To CHAGAN SINGH MANRUP SINGH

Assessment Year I 2005 Minor Head PUROHIT. Da you still want to Continue? AMR

Name ICHAMAN LAL PROP YES : |

Address IF'ATEL CHOWWIK ASR

Old TANI/PAN IAILPSEDEEK Current AD IWARD 2011, ASR

Neww Name ICHAGAN SINGH MAMNRUP SINGH PUROHIT

Remarks |

* Note:
-- All Query Criteria fields are mandatory
--Valid TAN/PAN challans need to be verified by both the AQ's.
Goto Precessing --= Challan Verification - Verification of Globally Claimed Challan scrren to verify this Challan.

Q 4. How does an AO/Range verify a challan claimed by AO globally?

Ans. Global Suspense challan Verification will be done by Inspector, AO and Range Incharge
depending upon challan amount. Range head can verify challans of amount >5 lacs. Global
challan having valid TAN/PAN Verification will be done by AO1 and AO?2. Please follow the steps

given below:

e For AO, Login into the OLTAS menu and follow the path: Processing --> Challan
Verification and press button “Verification of globally Claimed Challan”

e For Inspector and Range Incharge, Login into the OLTAS menu and follow the path:
Maintain Challan --> Global Challan Verification.

e Verify the challan or reject the challan

Q5. How a Challan can be migrated locally (within same RCC)?

Ans. Challan lying with some other AO in same RCC can be migrated by PAN - AO by using
Local Migration Functionality. Please follow the steps given below:

e Login in PDC=>Go to OLTAS->Maintain Challan-> Challan Details.
e Enter the CIN select ‘All" option and query for the desired challan.
e Check the 'Migrate Challan' checkbox and Save the changes.
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Query Criteria

“For migrating challans of PANS transferred vwithin RCC, use "Migrate Challan®™

Branch BSR Code

I’J’JFJFJ%[’JI @ Diltas Challan Deposit Date 15717202707 Cltas Challan Serial Mo. el

May 2013

Major Hend | Lﬁl Minor Hezad @I
TANPAN I Assessement Year Dltas Challan Deposit Date
Aamount |- | OR  Amount TO
MNodal Scroll Date From IO‘I.'CI6IQUU4 TQIQ'.’IOS.’ZEI‘IE “~ All  © Suspense © Requiring correction of TAN_PAN
© valldate data Requiring some Correction by AC  © Invalld data requiring correction by A0/DO
Challan Details Save Data to Excel
Cank Dranch Challan Zhalan Zaeque lare Address 1A grat=
Cocde  Code Seral Mo Dzposit Date = Date challan
Amsl Major Minor Arriuonl Rerra k= PLsL! AC Cude
rea” Head Hesd Corsuned
Flag =t
onn [ nan | al 1srzeonT [isnemnng [aonF=asae- | [cHAGAN SINZH W ANRT
roas| 21| 4no | 13610 [ 2315 | [eraian

R R E =
| | | | | -
I | I |
| | I | | | |
e | [ =

MNo. of Challans |1 Total Amount |'1-"5f3'1O Frint Report

Q 6. How a Challan can be migrated Globally (Across RCC)2

Ans. Challan lying in some RCC other than its PAN RCC can be migrated by AO to its PAN RCC
using Upload Challan of migrated PAN screen. Please follow the steps given below:

e Go to OLTAS-> Maintain Challan-> Upload challan of Migrated PAN.
e Enter the PAN and press ‘MIGRATE CHALLAN' button.

e The required flags are set and after 2-3 days, the challan will be visible in the jurisdiction
of the AO to which the PAN belongs.

| x| «| > DR e @ 2| SEIREIEY ss|||
EMT DRV EXELC LRMEEL [ (L LEFT RIGHT EAUE [LEAR. EXIT LIET KEY HELP ADD DEL GERI. FIRST LRST cut Copvy PRSTE

1. To aveid locking .Please run it at non working hours.

2. Retained PAN belonging to an AO can only transfer the challans.

PAMN/TAN |[“~CDPP3646N

MIGRATE CHALLANS

ITD Application Infarmative MNote

()

I-TAS31149 ; Migration process is over.The RCC
scheduler will further complete the process

NOTE: Challans pertaining to last financial year are automatically migrated through
scheduler.
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Q7. How can a correction be done by AO in a Challan?

Ans. AO can make correction on the suspense challans or Challans lying under his jurisdiction
from Challan Detail Screen. For details pse go through OLTAS ption No é available at i-taxnet.

Following correction can be made by AO:
e PAN
e Assessment Year
* Minot head Code
¢ Major head Code
Please follow the steps given below:
e Go to OLTAS-> Maintain Challan-> Challan Details.

e Select "Invalid data requiring correction by AO/DQ" option or “Valid data requiring
correction by AO/DQ" option depending upon value of Post Flag and query for the
challan.

e Press the ‘Correct records’ button and make the required corrections in challan, enter
remarks and save the record.

PR

LEFT RIGHT SAUE

B0

CEAR,

[216] &|8] &8

FIRST

|| W
EMITO3Y EREC IRYLEL LP oL

Query Criteria

Branch BSR Caode IL‘UUUSU’I @ Oltas Challan Deposit Date I’Ibf’lz:‘zUUf Oltas Challan Serial Mo.
Major Head I @l Minor Head I @
TAN/PAN I Assessement Yearl Oltas Challan Depaosit Date

Ll

Amount |= jl OR Amountl TO
Nodal Scroll Date  From ICI’EOGI2004 TQIQYIOOIQDQ T All  © Suspense ¢ Requiring correction of TAN_FPAN
 valldate data Requiring some Correction by AQ  © Invalld data requiring correction by AQIDO
Challan Details Saveo Data to Excol
Dank Cranch Chalan Clallan Chegusz  TARNTAN Old TANT AN MNarme Address
Code Code Seria Mo Deposic Dzte Cr Dat=
Asst Major  Minor Amount Rermarks Dedup Tobe Erro- Zost f AO code
fear Head Head Flag # werhed ~onsurmed
by Slag
B o201 41511242037 [15/06/2004 |ACDPP3626N | [CHAGAN SINGH VIANRUF|
2005| 21| 00| 13610 [17245 | 1 |oatan N EE E

[ | | | | | |

|| || | | | | | || | | | B o

e ! i =TT
Mo. of Challans |1 Total Amount |1331O Print Reportl Correct Records

# Dedup flag = U means this PAMN is under deduplication procoss
& Postf Consumed Flao is'A' o 'C'or 'H' means consurmed by 'AST or 'CPC! or 'Perdinog for Verification of 21d Chzllans ov Ranoe ncharoe' respect
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Q8. How can an AO/Range/CIT/CCIT view his collection in OLTAS?

Ans. Field formations can view collection figures through the screen. They can get summary as
well as details of challans falling under query criteria. Please check OLTAS Instruction No 31
available at i-taxnet for more details. Please follow the steps given below:

e Login to BCP RCC=>OLTAS=>Queries=>OLTAS 31 PAN based collection.

e Enter period and press execute query

This screen shows list of high value suspense refunds also. Details of challans can be exported to
excel sheet for further sorting efc.

QUERY CRITERIA Welcome ITO WD 24(3)-2 (NEW)
TAN { PAN | ccIT IMUM 13 ﬁ| ciT [Mum [24 rm|

Mode OFf Payment I @I Range Incharge IMUM |243 ﬂl AD IMUM IW— I% |2 @
Major Head li @I Minor Head I— @I Nature of Pymntli @I

Nodal branch screll date Fram I To I Pest Flag I j
(DDIMMIYY YY)
CHALLAHN DETAILS | REFUND DETAILS |
QUERY RESULTS Ii
Mo of encashed Refunds * No of challans I
Total amount of encashed Refunds I Total amount of challans I
SUSPENSE QUERY. Net Amount | e
Total Challan Lying In Suspense | Total Amount Of Challan Lying In Suspense
Total Refund Lying In Suspense Total Ameount Of Refund Lying In Suspense I

*There will be no value of refunds for any minor head

*There will be no value of refunds for any nature of payment
*The Number and Total ameount of challans and refunds displayed are betweenl andl

Q9. How can a Regular (400) challans be posted manually in AST ledger through OLTAS to
adjust against a demand.

Ans. Minor Head 400 Challans can be Posted manually by AO. Only those Challan can be
posted where amount in challan does not matches with the net demand amount. In case of
manually issued TMS refunds, refund details must be uploaded in AST before posting such
challans to avoid getting errored out. Please follow the steps given below:

¢ Go to OLTAS->Maintain Challan->Manual posting of 400 challans.
e Enter the Query criteria and press execute button.

e Click on the check box provided in front of the specific record which will automatically
be posted to Ledger.
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Manual Posting of minor head 400 Challans

200417 |? 05042007

[pacPhazazH _-
%JQQ#
( /[ 7 J7 |
[ [ RS [

Q 10. How to get a list of 500 top taxpayers (Advance, TDS, Self Assessment Tax) wise?

Ans. CIT can get a list of 500 top taxpayers and Range in charge can get a list of 100 top
taxpayers through the screen. Please follow the steps given below:

¢ Login to BCP=>OLTAS=>Queries=> List of top taxpayers.
e Select category , Minor Head and Quarter upto fields

e Press execute query button, the list will be generated which can be exported to Excel
sheet also.

Action Edit Eield Becord Query Help MWindow

to |Upto ath Qu... ~

NHPC LIMITED 18,00,00,000
HUAMWYETI TELECOMMUMNICATIONS INDLA C 2,60,67,520
= < AUTO LIMITED 2.26.20.665

MNAPING AUTO AND ELECTROMICS LIM?E" 1.65,00,000
KENDLE IND LA PRIVATE LIMITED 1.50,00,000
#0,00,000
75.00,000
70,000,000

65,70,000

=
50,13,350
50,000,000
50,00,000

(=1 £=2E=1 K=1 K=1 £=1 K=d £=2 £=1 E=1 K=1'k=
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Q 11. How to Claim manual Refunds (RT06) lying in Suspense?

May 2013

Ans. AO can login to ITD application to claim refunds lying in suspense. Please follow the steps

given below:

¢ Login to PDC=>OLTAS=>Maintain refund =>local Suspense Refund claiming

e Populate valid PAN and press save button.

tl4| szl 2|28 BI©| &

Claiming of Local Suspense Refund version 1.0 Released in et 2009

_ Below 10000 &
01042005 30/06/2008

pracromsac  [ormranesn | v o o [
e [
pevicise [anncwos | oo Jors  [ox
-
paseemeae [sumoncraner | s Joses < i |
N T = T
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e-TDS Application

Q1. Whether AO can modify/edit the details of the e-TDS statement?

Ans. There is no provision to edit any details of the statement by AO. If any correction in the
statement needs to be done then deductor should file the correction statement.

Q 2. The deductor has deducted the tax at lower rate/not deducted and system has generated
the short deduction defaults. In this case, deductor is not able to ascertain how short deduction
default has been arrived at. How to rectify quarterly TDS statement?

Ans. The reason for discrepancy is that deductor might not have entered the relevant field i.e.
“Reasons for non-deductions/lower deduction” in the quarterly TDS statement. If it has been
deducted at lower rate, the same has to be mentioned in the relevant field in the statement. If
such error exists deductor may be asked to file the correction statement.

Q 3. A number of deductors make the mistake of reporting the date of tendering of the cheque
in the e-TDS statement. This leads to mismatch of challan and results in short payment cases.

Ans. Currently, payment date is relaxed by seven days to match the tender date and cheque
realization date. Deductors may be advised to check correct CIN particulars from tin-nsdl
website. (http://www.tin-nsdl.com)

Q4. s there any way to find out whether the TDS deposited was made in compliance of an
order under section 201(1) or voluntarily?

Ans. Yes, the deductor should mention minor head as 200 for voluntary payments and 400 if
paid in compliance of an order u/s 201(1).The same can be viewed in a report which can be
taken out from “Report for Demand vs. Collection”. Navigation for the same is:-

TDS >Reports>Demand and Collection >Report For Demand vs. Collection.
Q5. Deductor has quoted wrong TAN, Section Code, Financial Year,Minor head code while
paying the challan. How to rectify this?

Ans. Correction in the challan in TDS module ITD application has been on hold, changes in the
challan can be done after roll out of CPC TDS application for challan correction mechanism.

Q 6. Can the AO edit any information in the certificate issued u/s 197 for TDS/TCS lower/no
deduction?

Ans. AO can edit the TAN and PAN address information only until the certificate is printed.

Q7. The assessee has PAN APMPSXXXXF when he got deduction of TDS. Later this PAN of
assessee has been deleted and new PAN AQBPSXXXXD has been allotted and he has used it in
his e-filed statement. How can we credit the TDS amount which has been deducted on the old
PAN of the assesee on the new PAN?2

Ans. The problem can be resolved only by filing correction statement by the deductors replacing
old PAN with new PAN.
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Q 8. What should an assessee do in case there are some entries in his Form 26AS that do not
pertain to him?2

Ans. In case this is on account of TDS/TCS credit, assessee may intimate the deductor/collector.
In case this is on account of advance tax/self assessment tax, assessee may intimate his assessing
officer.

Q9. Can negative (-') entries appear in Form 26AS?

Ans. If there is any error in the TDS/TCS statements or in the challan details uploaded by the
bank and the same has been rectified, the original credit entry will be reversed by way of a debit
entry in Form 26AS and a new credit entry (if applicable) will be posted. All the negative entries
which are basically contra-entries are shown in parenthesis (brackets).

Q 10. Can Certificate U/s 197for lower/no deduction be issued with zero (0) tax rates?

Ans. Yes, it can be issued.

Q 11. How International taxation charges view the 15CA Certificate in ITD application?

Ans. AO of International taxation in TDS module having role of “AR_INT_TAXATION” can view
the 15CA information along with 27Q statement. This role will be assigned by concerned
Regional Computer Centre; user may contact RCC for the same.

Q 12. In the International Taxation AO code, challan u/s. 195 is reflected in the oltas data but
statement with form 27Q are not reflected under my jurisdiction. What is the procedure to follow
up action to access form 27Q in my jurisdiction?

Ans. As per procedure, CIT (INT) charge should nominate one person to execute the role of
transferring 27Q TDS statements from one AO code to another AO Code. The nominated person
should get the role of AR XFER JURIS INT TAX allotted from the concerned computer centre.
User shall be able to view and process statements once the TANs are transferred to him.

Q 13. How to update the name, category of deductor and address of the TAN holder?

Ans.  Deductor can apply for the updates of TAN details through TIN (FC) vide application form
name “Form for Changes for correction in TAN data”. Deductor can also send the application to
the concerned AO for updating the TAN details. AO can in turn update the TAN details through
“TDS-->Deductor 2 Update Deductor Information”

Q 14. How can the position of outstanding demand in respect of each TAN be obtained from
the system?

Ans. Report can be taken out from “Report for Demand”. Navigation for the same is:-

TDS >Reports>Demand and Collection >Report For Demand.

Q 15. How to reduce the demand while rectifying the order?

Ans. Currently modification of demand calculated by system is not possible. Processing Original
and correction statement from now onwards will happen in CPC TDS
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Q 16. How to give credit of challan to any statement to reduce the short payment?

Ans. Claiming of challan through TDS module of TDS application has been put on hold. All
these activities will take place in CPC TDS.

Q 17. Corrections have been filed by deductor but it is not reflecting in the system?

Ans. Processing of Correction statement will take place in CPC TDS and hence the same is not
getting processed in ITD application.
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AR and CIB

Q 1. What is Individual Transaction Statement (ITS)?

Ans. A repository of assessee-wise transactions (with PAN) is called ITS. Transactions coming
through AIR, TDS returns, CIB & Tax Payment through challan (OLTAS), ITR, FIU and OECD are
used to prepare ITS.

Q 2. Who can access ITS?

Ans. AO, Range in charge, CIT and CCIT can access ITS on jurisdictional basis.
Officers of Investigation wing and Intelligence wing can access ITS all india basis.
Q3. Can AO access all ITS under his jurisdiction?

Ans. No, he can only access the ITS of the PANs selected either through CASS or PANs are in
non filer list. However, unrestricted access in respect of PANs falling in relevant jurisdiction is
available to Range head and CIT.

Q4. Whatis global access?

Ans. All India access of ITS, ITR and PAN is called global access. This facility is available for
officers of Investigation wing and Intelligence wing.

Q5. What are steps involved to access ITS/ITD for intelligence wing /investigation wing?

Ans. First of all, information of officers (valid Emp No, Name, Designation, RCC) is required to
be sent to NCC by the Investigation/Intelligence wing.

Then RCC assigns Application Role according to Designation. After that officer with valid RSA
may login to ITD and access ITS using path ‘->EFS->CIB->ITS->Query ITS’

Q 6. Can source of income of PAN be known through ITS?

Ans. Yes. Income from business on the basis of business code as provided in ITR as well as NOP
as mentioned in 26AS be known.

Q7. Can List of organization be generated through ITS?

Ans. Yes. On the basis of business codes (Income from business) as provided in ITR, list of
organization can be reported in excel.

Q8. Can CTR of FIU be accessed through?

Ans. Yes. FIU details button may be used to access the CTR.

Q9. Who can upload the CIB information in ITD?2

Ans. Any officer having application role of CIB Admin may upload CIB information.
Q 10. Is any file format is required to upload the CIB information?

Ans. Yes, data in specified file format only be uploaded.

Q 11. Is there only one file format for all data?

Ans. No, there are 16 compulsory codes and every code has separate file format.
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Q 12. Is any software/utility is required to convert the data in standard file format?
Ans. No, data in excel sheet may easily be converted in standard  file format.
Q 13. What are the steps involved to upload the CIB data?

Ans. In compulsory codes, first of all filing agency information(Part A) is uploaded through excel
sheet. Then transaction information (Part B) is uploaded through excel sheet. The Part B file is
uploaded through night scheduler.

When the Part B information is uploaded, receipt is marked closed. Only after the receipt status is
closed, PAN is validated and data is posted to ITS.

If the data is in old format (Like MCX, NSE, etc) , first of all, receipt of data is created through
‘Maintain Transaction Receipt’ facility. Then Transactions are imported through ‘Import Financial
Transaction’. After the successful import, transaction receipt is marked closed and data is posted
to ITS.

Q 14. How can PAN be populated in Non PAN CIB transactions?

Ans. PAN can be populated in Non PAN CIB transaction using functionality ‘Resolve /Update
PAN in NON PAN CIB Transactions'.

Q 15. How can PAN be populated in Non PAN AIR transactions?

Ans. PAN can be populated in Non PAN AIR transaction using functionality ‘Resolve /Update
PAN in NON PAN AIR".

Q 16. How can list of Non filer be generated for 50 C transactions?

Ans. A Screen Non filer w.r.t 50C is available in ITD under path ‘EFS->CIB->CIB Processing’to
field authorities, Investigation Wing /Intelligence Wing to access/view and copy in excel.

Q 17. How can list of Non filer be generated for MCX C transactions?

Ans. A Screen Non filer w.r.t MCX is available in ITD under path —'EFS->CIB->CIB Processing’
to field authorities, Investigation Wing /Intelligence Wing to access/view and copy in excel.

Q 18. How can PAN be searched for Non-PAN transactions?
Ans. For Manual PAN search, CBN facility is available to Investigation /Intelligence wing.
Q 19. How can Non-PAN data be processed and disseminated to field authorities?

Ans. As the Non PAN data is in large volume, it can be processed in Batch Mode only. There
are following steps to disseminate the data;

e Standardization of Transaction
e Party Building
e Case generation
e Dissemination to Range/AO.
Q 20. How can AO knows that ITS is available for the PAN under his jurisdiction?

Ans.  When the AO access the scrutiny cases in AST, There is flag which shows ITS is available or
AOQO can view the ITS using Path ->EFS->CIB->ITS->Query ITS.
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i-taxnet

Q1. Whatis i-taxnet?

Ans. i-taxnet is a web-enabled application which can be accessed by the members of the Income
Tax Department through a web browser. This intranet application is deployed at the Primary Data
Centre (PDC), New Delhi and is available on the existing Income Tax network (TAXNET). The

functions of main modules of i-taxnet are as under:
¢ ‘Messages module’ for sending messages.
e ‘Workgroups module’ for working of virtual groups with private forums and documents.

e ‘Reports module’ for electronic compilation and transmission of statistical reports i.e. CAP
| report, CAP Il report and arrear dossiers

e ‘Resources module’ which provides online publications, training materials, discussion
forums, problem solution forums etc. with facility to capture the experience of officers.

e ‘Member’'s module’ which provides online telephone directory, official hierarchy and
location hierarchy.
Q 2. What is the roadmap of i-taxnet for 2013-14
Ans. Changes planned in i-taxnet are:

e Integration of i-taxnet modules (Single sign on for CAP-lI, CAP-ll and Dossier with
integrated hierarchy maintenance)

e Rollout of new CAP-Il (Separate report templates for 13 different functions with facility to
download xml template, fill it offline and later upload to the i-taxnet)

¢ Roll out of Non Filer Monitoring System (Business Intelligence Pilot Project)

Figure: Screen shot of new integrated i-taxnet
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Q 3. What are the various statuses of CAP-I and CAP-Il reports?
Ans. The statuses of CAP-I and CAP-II reports are:

e Draft: When office at entry level has keyed in the figures and saved the report but
not compiled.

e Entered: When office at entry level has compiled the report.

e Pending: This is the status of ‘office at report compilation level’, when any of the
sub-ordinate offices has not compiled the report.

e Pending compilation: This is status of ‘office at report compilation level’, when all
sub-ordinate offices have compiled their reports

e Compiled: When ‘office at report compilation level’ has compiled his report,
which is consolidated subordinates reports.
Q 4. What are the various statuses of Dossier reports?
Ans. The statuses of Dossier reports are:

e Draft: When office at entry level has keyed in the figures and saved the report but
not compiled.

e Pending: When ‘office at report compilation level’ has not compiled the report.

e Compiled: When ‘office at report compilation level’ has compiled report.

Q5. How to create a new CAP-II report?

Ans. New report can be created by clicking on the button ‘New’. In case of ‘offices at report entry
level” this action can be taken when no report has been entered. In case of ‘offices at report
compilation level’, a new report can be created only if no report has been compiled for that level.

Q 6. How to create a new CAP-I report?

Ans. Only Assessing officer can create a new report by clicking on the button ‘Add’. The new
report shows values from the previous month report if a report was entered in the previous month
else a blank report is shown. No other office above AQO level can create a new report.

Q7. How to create a new Dossier report?

Ans. Only Assessing officer can create a new report by clicking on the button ‘Add’. The next
screen shows all Dossiers of previous quarter along with “Copy” button, by this any previous
quarter dossier can be copied to current quarter. The page also shows a “New” button for
creating a new report. No other office above AO level can create a new report.

Q 8. How to edit a CAP-Il report?

Ans. Report can be edited by clicking on the button ‘Edit’. In case of ‘offices at report entry level’,
this action can only be taken when report has been saved as draft before it is sent for
compilation. For ‘offices at report compilation level’, editing a report means entering a report at
that level which will override the reports of the subordinates for compilation purposes. This action
cannot be taken if report has already been compiled.
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Q9. How to edit a CAP-I and Dossier report?

Ans. Edit a report by clicking on the button ‘Edit’. In case of ‘offices at report entry level’, this
action can only be taken when report has been saved as draft before it is sent for compilation.
‘Offices at report compilation level’, cannot edit a report.

Q 10. How to compile a report?

Ans. Compiling a report means sending it for further compilation to the senior. Any report, which
has been sent for compilation, cannot be edited. In case of ‘offices at report entry level’, draft
report can be sent for compilation. In case of ‘offices at report compilation level’, compilation can
take place only when all reports of the subordinates have been compiled (pending compilation
stage). Clicking the ‘Compile’ button will submit the report for upward compilation. The report
will then be available for seniors.

Q 11. How to override a CAP-1l compiled report?

Ans. Any ‘office at report compilation level’ has the option of either waiting for the report to be
compiled from the subordinates or enter its own report. Report will generally be entered at
compilation level when the subordinates are delaying entry of report or there are mistakes in
compiled report. If the report is entered for an office, which is not at the cutting edge, a warning
message will be flashed stating that if report is entered the compiled figures of subordinate offices
will be ignored for upward compilation. However if the report is entered the compiled report from
subordinates would be ignored and entered report will be used for upward compilation.

Q 12. How to change a compiled CAP-I report?

Ans. Only Assessing officer can enter or edit a report, all other officers can only compile or
uncompile a report. The ‘office at report compilation level’ has to uncompile his compiled report,
which will then be available for editing at assessing officer level.

Q 13. How to change a compiled Dossier report?

Ans. Only Assessing officer can enter a report, all other officers can only compile or uncompile a
report. The ‘office at report compilation level’ has to uncompile the report, which will then be
available at Assessing officer level for editing.

Q 14. How to see the breakup of any compiled figure?

Ans. The CAP-1 and CAP-Il reports of offices above entry level, show hyperlink on figures entered.
If hyper linked figure is clicked, the breakup of figure for subordinate offices will be displayed fill
the level of data entry is reached.

Q 15. How to view the report of any subordinate?

Ans. There is a subordinate panel showing status of reports against each of the subordinate
office. Clicking on the link ‘View Report’ next to the office would display the reports of the
subordinate.

Q 16. How to take printout of report?

Ans. A link ‘Print’ is available in all the reports. Clicking on this link will open a printer friendly
version of the report, which can be printed for record purposes.
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Record Management System (RMS)

Q 1. What is Record Management System (RMS)?

Ans. Record Management System (RMS) has been designed to automate process of record
keeping. The system is specially designed to keep ITR bundles in a specified record room. Once
the bundles are placed in the record room using RMS then ITRs can easily be tracked. At present
RMS is being used at 21 locations. The objectives of RMS are

e To facilitate protection and preservation of records.

e To provide integrity and continuity regardless of changes in personnel.
e To provide low cost and efficient maintenance of records.

e To reduce the possibility of misfiling and misplacement.

e To ensure less time spent on searching of files and documents.
Figure: RMS Dashboard
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Q 2. What are the steps in implementing RMS?
Ans. The implementation steps are as under:
1. Decide the level (AO / Range / CIT /CCIT level) of implementation

e AO level — If RMS is to be implemented at AO level then AQ’s record room will be the
record room for RMS and role of Record Manager can be assigned to AO's staff.
Therefore, extra space, additional node and computer are not required. This option is
for single AO office.
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e Range level — If RMS is to be implemented at range level then a common record room
should be identified. One node, one computer and one staff will be required to
maintain all records of range.

e CIT level - If RMS is to be implemented at CIT level then a big common record room
should be identified. Two nodes, two computers and two staffs will be required to
maintain all records of CIT charge centrally. This requirement may vary depending on
the number of AOs under the CIT charge.

2. Identify a room in the building that can be made as “Record Room”

3. Appoint a Nodal officer of the rank of AO or above in each building where RMS is to be
implemented. Nodal officer has to co-ordinate with DIT (Systems) in the implementation
of RMS.

Identify Record Managers from the staff to use RMS.

Communicate the employee details like name, designation, employee id etc to Local
Administrator of your RCC for granting Record Manager’s role.

6. Local Administrator will assign the role of Record Manager and map the assessing
officer’s office which is to be maintained by Record Manager.

7. Record Manager will create record room profile and assign room, rack and shelf to
different assessing officer’s offices.

8. Record manager will confirm the returns in a bundle and also confirm location where the
bundle is to be placed. Record Manager is the main custodian of records and responsible
for all records once placed in the record room.

Q3. How can | access the RMS system?

Ans. Open internet explorer and enter http://10.152.2.14:88/ltaxnet. A home page will be
displayed. Click on “Record Manager” and enter your RMS user ID and password for login.

Q 4. What are the prerequisites for implementing RMS?

Ans. RMS can be accessed using URL http://10.152.2.14:88/Itaxnet. Only requirement is to
create “Record Manager Role”. Record room and staff should be identified in a building where
RMS is to be implemented. Please refer to implementation steps provided earlier.

Q5. Whether RMS can be implemented in any building across the country?

Ans. Yes, RMS can be implemented in any building irrespective of whether Sevottam (ASK centre)
is functional or not.

Q 6. Which ITRs can be captured in RMS?
Ans. All types of returns can be captured and managed in RMS.

Q7. Whether old ITRs processed on AST can be placed in record room by RMS?2

Ans. Yes, old ITR bundles can be placed in the record room. A request is to be initiated by Record
Manager in the software to pull old AST returns for placing them in the record room.
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Q 8. Can RMS use information available in AST module of ITD Application?

Ans. There is no need to enter details of ITRs already entered in the AST module of ITD
application. ITR details are pulled along with the Bundles from AST.

Q9. Whether RMS can be implemented at AO level?
Ans. Yes, RMS can be implemented at any level from AO to CCIT level.

Q 10. How many RMS users can exists in a building?

Ans. Depending on the volume of work and level of implementation of RMS, multiple Record
Managers can be created in a building.

Q 11. What happens if | forget my login password?

Ans. Contact your Local Administrator to reset the password.

Q 12. How long will the user session be active?

Ans. If you do not perform any operation for 10 minutes, the session will expire and you will be
logged out automatically.
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Sevottam and Aayakar Seva Kendra (ASK)

Q1. Whatis Sevottam?

Ans. Sevottam is aimed at promoting “Excellence in Service Delivery” through implementation,
monitoring and review of citizen’s charter and enabling receipt, redressal and prevention of
public grievances. At the core of Sevottam is the Aayakar Seva Kendra (ASK) which is a one stop
computerized shop for the taxpayers to obtain services promised by the Department in its
Citizen’s Charter in a time bound manner. In order to achieve these objectives, Sevottam
provides for a front office to be backed by re-engineered processes and a new outlook of the
personnel so that grievances of taxpayers are not only redressed quickly but also eventually
prevented. The first ASK was established at Pune in May 2009. At present there are 141 ASK in
operation.

Figure: Sevottam Dashboard
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Q 2. What are the functionalities of Sevottam?
Ans. Functionalities in Sevottam are:

e Dak receipt: Daks of various categories like Appeals, Technical Document, Citizen’s
Charter, Grievance, Exemption, Administration and others can be received through
Sevottam. The due date for resolution of Dak is calculated on the basis of citizen’s charter.
An acknowledgement slip with unique ASK ack number is also generated.

e Return receipt: Paper returns of different form types can be received through Sevottam. An
acknowledgement slip with unique ASK ack number is also generated. This RRR entry is
automatically pushed to AST.
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e Pre-printed slips: During peak return filing days, Pre-printed slips can be generated in
advance. Pre-printed slips generation facility is given to all AOs. Entry of such return can
be done by AO as well as back desk users. These slips can be used for the return receipt
purpose only. Entries against such returns can be done within 15 days.

e Bulk lot acceptance: Bulk lot number can be generated when a person comes with a
bunch of more than 5 returns. Entries against such returns can be done within 15 days.

e Capture action on Dak: Sevottam capturesinformation related to disposal of
DAK/Grievance with dispatch and resolution details.

e Enable KYC for out sourced person: A bio-data of out sourced person has to be fed into
system. After approval from competent authority, Local administrator generates temporary
user ID with password for the outsourced person. Out sourced person can log into
Sevottam with limited predefined privileges.

e Monitoring the status of Daks: MIS is available to supervisors to monitor the status of Daks
pending/resolved by section diary officers.

e Information centre: Sevottam provides status of Dak, Return and PAN jurisdiction/status.

Q 3. What is Roadmap of Sevottam for 2013-142
Ans. Changes planned in Sevottam are:
e Pushing the correction of A.Y., ITR Type of RRRs to AST
e Pushing of Sevottam Bundle numbers to AST
e Pushing rectification requests to AST and fetching the status back
e Showing processing status of Sevottam Returns

e Showing Refund Status

Q 4. How to access Sevottam application?

Ans. Sevottam application can be accessed by using URL
http://10.152.2.14:88/Sevottamorhttp://10.152.2.14:88/ltaxnet and click on “Sevottam”. In the
login page, enter user ID and password.

Q5. When user tries to login with his user ID/Password then message “invalid user
ID/Password” is displayed.

Ans. The user is trying with incorrect user ID or Password. User ID is a six digit employee code
XXXXXX. There is no ‘U’ appended to it. If the user does not remember his password then he
should contact local RCC administrator for Password to be reset to default. User would be
required to change the default password on login.By trying with correct login credentials this
problem is resolved.

Q 6. When user tries to login with his user ID/Password then a message “User Role not
defined” is displayed to user.

Ans. The user employee code is not tagged to any role. User should contact local RCC
administrator to tag his employee code with the required role.
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Q7. Who are Front Desk (FB)/Back Desk (BD) users?

Ans. Front Desk users are TAs/STAs who receive Dak and returns by hand and enter these in
Sevottam. Back desk users are also TAs/STAs who receive Daks other than by hand and enter
these in Sevottam. Back Desk users also enter returns received against Preprinted Slips and Bulk
lots. After generating Dak Distribution Register (DDR) and Return Distribution Register (RDR) all
Daks and Returns received by FD/BD are distributed to the concerned section diary officers.

Q8. Who are section diary users?

Ans. All officers in the hierarchy from AO and above are section diary users to whom
Dak/Returns are addressed.

Q9. What needs to be done if the Front Desk user has entered incorrect PAN while Return
entry?

Ans. As the Return has been entered with incorrect PAN, the user has to log a ticket in Codesk
and provide the scanned copy of ITR received in ASK.

a) If the Return has already been Posted to AST then the concerned AO has to delete
incorrect Return from AST after this the Return in Sevottam will be deleted based on the
corrections done in AST by AO and the scanned copy provided with the ticket.

b) If the Return is not yet Posted to AST then the Return is deleted based on the scanned copy
provided by user with the ticket.

Q 10. What needs to be done if the Front Desk user entered incorrect assessment year while
Return entry?

Ans. The Assessment Year for the Return received can be corrected within 15 days in Sevottam as
after this the return is posted to AST. If it could not get corrected within this time then user has to
log a ticket in Codesk along with scanned copy of ITR received. If the Return has been posted to
AST then concerned AO has to correct in AST and after this the correction will be done in
Sevottam.

Q 11. What needs to be done if the Front Desk user has entered incorrect Return Type while
Return entry?

Ans. The user has to log a ticket on Codesk and attach the scanned copy of Return received.
Return type can be original or revised. This will be corrected as per the details provided by user.
Q 12. What needs to be done if the Front Desk user has entered Return as normal Return but it
was received in Bulk Lot?

Ans. Normal Return entry will affect assessee as the last date of receipt of Return is over. The user
has to log a ticket in Codesk and attach the scanned copy of ITR received. The Return will be
deleted from Sevottam and user will be informed to enter the return under Bulk lot.

Q 13. How to delete DAK due to some mistakes in the entry?

Ans. User has to log a ticket in Codesk. The DAK status will be marked as Deleted. This can be
traced with the ASK no or under status Deleted in Sevottam by FD/BD users.
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Q 14. What needs to be done if the FD user gets message “PAN hierarchy does not exist”
message on entering PAN of assessee?

Ans. The user has to contact local administrator to get the hierarchy of PAN AO marked up to CIT
and ensure that AO code is also entered for the AO.

Q 15. What needs to be done if the FD user submits Return/DAK but no user designation from
his building is populated in list?

Ans. The user has to contact local administrator to get the hierarchy details of the building
entered properly.

Q 16. How can the Section Diary (SD) user mark DAK to his Subordinate if there is no
designation in the list2

Ans. The Section Diary user has to contact local administrator to update his subordinates in the
hierarchy.

Q 17. Why does a temporary user get the message “incorrect UserlD/Password”.

Ans. Temporary or contract users have to login from “Temporary User” link on the page
displayed on URL http://10.152.2.14:88/ltaxnet.
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Aayakar Sampark Kendra

Q 1. Whatis Aayakar Sampark Kendra?

Ans. Aayakar Sampark Kendra is the Call Center Service of Income Tax Department. A toll free
no. 18001801961 and short code 1961 is operational throughout the country across all the
telecom operators for both landlines as well as mobiles. M/s Sparsh BPO Services Limited is the
Service Provider, who is running the National Call Center (NCC) at Gurgaon and Regional Call
Centers (RCC) at Jammu, Jangipur, Shillong & Kochi. The then Union Finance Minister
inaugurated Aayakar Sampark Kendra and dedicated the Call Center Services of Income Tax

Department to the Nation on 14th April 2012.
Aayakar }
Sampark &

Kendra
> TOLL FREE Nos. 1961
1800-180-1961

Q 2. What are the services provided by Aayakar Sampark Kendra?

Ans. Aayakar Sampark Kendra (ASK) aims to have simple, transparent, direct & user friendly
Interaction with taxpayers for dissemination of information by means of Help line toll free no.
18001801961 and short code 1961and via email to ask@incometaxindia.gov.in.The taxpayers
get information on the following:-

e Income Tax Return Forms, Wealth Tax Return Forms, modes of filing of returns,
assessment jurisdiction.

e Procedure of e-filing of income tax returns, with or without digital signature.

e Country wide facilities for assistance in e-filing of income tax returns & facility to send
forms by e-mail and facility for assistance in downloading of various forms/challans and
return preparation software.

e Procedure of making tax payment, including e-payment and payment through ATM.

e Answering queries related to information regarding, PAN/TAN applications and/ or
challans for payment of taxes.

e Status of Refunds and Procedure of viewing Tax Credit Statement and registration for Tax
Credit Statements.

e List of Tax Information Network Facilitation Centers and the PAN Service
¢ Miscellaneous matters

Other Services;

e To provide the facility for sending Bulk SMS/Bulk e-mails to the tax payers/customers.
e To play an active role in promoting the services offered by ASK.

e To provide such other services as specified by the Department.
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Q 3. What is the manpower at Aayakar Sampark Kendra?
Ans. The manpower in NCC/RCC consists of:

e TRA (Taxpayer Relationship Agent)

e Supervisor

e Quality Agent

e Team Leader

e Project Manager

Q 4. How to contact Aayakar Sampark Kendra?

Ans. Aayokar Sampark Kendra can be accessed by calling on the toll free number.
18001801961 and short code 1961 which is operational throughout the country across all
the telecom operators for both landlines as well as mobile or 0124 243800 (Toll No. India &
Abroad).Income tax related queries could also be mailed to ask@incometaxindia.gov.in.

Q5. What are the working hours during which CPC call center can be contacted?

Ans. The National Call Centre at Gurgoan and all the Regional Call Centers are operational
from 8 AM to 10 PM from Monday to Saturday. There are two shifts: Morning Shift from 8 AM to
3 PM and Evening Shift from 3 PM to 10 PM.

Q 6. What is the first option available on the IVR2

Ans. The first option available is to select the language preference.

Q7. What language options will be available to the caller?

Ans. Calls are mapped to NCC or RCCs based on Caller Identification i.e., STD code, mobile
number etc. on basis of which the caller is provided the language options available at the NCC
or RCC as per the categorization provided herein below:-

SI.No. | NCC/RCC Area Languages

1. Jangipur West Bengal and Orissa. Hindi, English, Bengali and Odia.

2. Shillong North Eastern States, Sikkim | Hindi, English, Assamese
Bihar, Jharkhand.

3. Jammu J & K, Himachal Pradesh | Hindi, English, Punjabi and Kashmiri.
and Punjab.

4. Kochi Kerala and Tamilnadu. Hindi, English, Malayalam &Tamil.

5. Gurgaon Rest of India. Hindi and English.
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Q8.

What are the options available to the caller on IVRS after language selection?

Ans. As per the current Integrated Voice response System (IVRS), the following options are
available to the caller in the language selected by him:

Q9.

English Options
e Press 1 for PAN

e Press 2 for E-filing of IT Return and refunds
e Press 3 for payment of Taxes
e Press 4 for Any other information

e Press 5 to speak with a Tax Relationship Agent

What are the different categories on which an agent (TRA) can give information?

Ans. The agent can provide information on the below categories:

Q 10.

Income Tax Return Forms, Wealth Tax Return Forms,

Modes of filing of returns.

Assessment jurisdiction.

Procedure of e-filing of income tax returns, with or without digital signature.

Country wide facilities for assistance in e-filing of income tax returns & facility to send
forms by e-mail

Assistance in downloading of various forms/challans and return preparation software.
Procedure of making tax payment, including e-payment and payment through ATM.

Answering queries related to information regarding, PAN/TAN applications and/ or
challans for payment of taxes.

Status of Refunds and Procedure of viewing Tax Credit Statement and registration for Tax
Credit Statements.

List of Tax Information Network Facilitation Centers and the PAN Service

Miscellaneous matters

Whether caller can file complaint(s)2

Ans. The callers may file their complaints via telephonic conversation on the toll free number.
18001801961 and short code 1961. The caller may press option 5 on IVRS after language
selection and speak to the Tax Relationship Agent (TRA).The caller is provided a ticket number for
each such complaint and he may track or follow up by quoting the ticket number during
subsequent call(s).

Q1.

How are queries related to downloading of forms resolved?

Ans. The user has to provide his email ID. The caller is provided a ticket number for such query
and the forms are downloaded and mailed to him at the email ID provided by him.
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Q 12. What happens if the caller has put forth a query to which the TRA has sought time to
reply?

Ans. The TRA shall either call back the caller or send the relevant information to the caller by
email and inform him by making an outbound call.

Q 13. What happens if the call was dropped before conversation was completed and ticket
number was issued to the caller.

Ans. There is a facility at ASK to make outbound calls and in all cases where calls are dropped
before issue of ticket number, the TRAs call back the caller and provide the relevant information
sought by the caller.

Q 14. What is the escalation procedure followed?

Ans. If the tax payer is unhappy with solution given at the agent level, or wants to speak to the
next level then the call is escalated to a supervisor. If the tax payer wants to escalate it still further
then the call is handled by Team Leader and that is the final level of escalation. Also, all the calls
made to ASK are recorded for monitoring and training purposes.
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RSA Tokens

Q 1. | am a new Officer joining the field after completing training. How to get the RSA Token?

Ans. An application is to be made through your AddI.CIT/JCIT to the CIT (CO) of CCIT(CCA)
region with the particulars like Name, Employee Code, Designation, Building Name where
posted, Phone no. etc. This application can be made after the Employee Code has been
generated.

Q 2. What is RSA PIN and how to change it?

Ans. RSA PIN is the first component of the RSA Password which a user knows / remembers and
is different from the RSA Code displayed on the RSA Token. While the RSA Code on the RSA
Token changes every 60 seconds, the RSA PIN is the constant component. This makes the solution
more secured. For details please refer to the RSA PIN Change Manual issued by the Directorate,
which is available on the website http://irsofficersonline.gov.in at DG Systems Corner. The PIN
can be changed at the link below:

http://rsaregister.incometax.net/RSASWE/WXUserHome.do

Q 3. What needs to be done if the RSA Token has got damaged / lost?

Ans. Please contact the CIT (CO) and FMS Helpdesk in this regard. A new token can be issued as
per the RSA Token Policy issued by the Directorate, which is available on the website
http://irsofficersonline.gov.in at DG Systems Corner.

Q 4. What needs to be done if the RSA has gone faulty with partial or no display, but with no
physical damage?

Ans. In case of RSA token gone faulty user should hand over the token to CIT-CO office and CIT-
CO office would hand over new token to user. CIT-CO office may further hand over the faulty
token to Helpdesk under proper communication and Helpdesk in turn to log call with PDC team
and send the token to Delhi for further replacement.
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Desktops & Laptops

Q1. My Laptop provided under the 1% incentive scheme, has developed some problem.
Whom to contact in this regard?

Ans. As per the directions of the Board, the respective CCITs (CCA) are required to maintain and
service these Laptops of the Officers in their respective regions. Please find out the information
about the same from the HQ of the CCIT (CCA). In case no AMC is in place for these Laptops,
request can be made to the HoD for the specific work/part of the Laptop.

Q 2. My Laptop provided under the 1% incentive scheme, has got stolen / lost / damaged.
What to do in this regard? How to get a replacement laptop?

Ans. The Officers are required to maintain the laptop safely. Normally, the replacement is not
being provided. Request can be made to CCIT (CCA) for replacement and will be dealt with on a
case-to case basis.

Q 3. My computer/desktop is very slow. How to remedy this?

Ans. Please contact FMS Helpdesk and register a request. For proper working of the computers,
please follow the “Dos and Donts” issued by the Directorate, which is available on the website
http://irsofficersonline.gov.in at DG Systems Corner. If the problem is not resolved, FMS engineer
can check the configuration of the computer and if configuration is low, a request can be made
to HoD for a new computer / upgrade of configuration.

Q4. | am a not very tech savvy. Whether any guidelines have been issued for the users to
enable them to have a safe and faster computing experience on the computers?

Ans. Please refer to the “Dos and Donts” issued by the Directorate, which is available on the
website http://irsofficersonline.gov.in at DG Systems Corner.
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Facility Management Services (FMS)

Q 1. Whatis FMS and how to contact them?

Ans. Facility Management Services (FMS) engineers provide services to the departmental users in
respect of computers connected to the departmental network namely Taxnet. An online tool Co-
desk and Toll-free number (1800110015) is provided to user to register problems being faced on
these PCs. A chart providing various options to log calls and the Co-Desk Guide is available on
the website http://irsofficersonline.gov.in at DG Systems Corner. User can log calls related to
Software issues, Hardware issue, ITD Application issues, Virus issues, RSA Token issues, Printing
issues, Network issues etc. Once the call is logged the necessary action is taken by FMS Helpdesk
and engineer rectifies the local issues. But if the issue has any dependency on some other vendor
like Bharti (for Connectivity to PDC & LAN of building), TCS (for ITD application issues) or
Hardware AMC vendor (for PC, Printer, UPS hardware) engineer will log call with necessary
Vendor and follow up till rectification. The contact details of all FMS engineers, building-wise, as
well as their escalation matrix is available on the website http://irsofficersonline.gov.in at DG
Systems Corner.

Q2. MyFMS Ticket has been closed whereas the issue is unresolved. What should | do?

Ans. Please follow up / check status on co-desk and update from your side so that a ticket is not
closed in this manner. If a ticket is closed without being resolved, user may write to CIT (CO) for
proper action and also give appropriate feedback in the user feedback survey. Escalation Matrix
for the IBM FMS, which is available on the website http://irsofficersonline.gov.in at DG Systems
Corner, users may contact the Regional Facility Manager / National Facility Manager for further
action.

Q3. My FMS Ticket for ITD Application/CPC related issue is pending for long. How to get it
resolved?

Ans. As far as tickets pertaining to ITD Application, CPC, etc.; FMS generally forwards the same
to the respective Application Team and the complaint is resolved by such teams working under
the supervision and control of the Directorate of Income Tax (Systems). In case of urgency of the
issue, the same may be taken up with the Directorate through proper channel.
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Website & Official e-Mail

Q 1. How to get an email id on the departmental website www.incometaxindia.gov.in?

Ans. The Official web-based email ids are normally available only to the Officers of the rank of
Commissioner of Income Tax and above, or officers of the CBDT and its attached offices. Such e-
mails have already been created for all eligible officers, which are by official designation. In case
of any query, Officer may contact the Directorate of Income Tax (Systems) or write to
webmanager@incometaxindia.gov.in in this regard. For official communications all the users
have been provided email id on the Lotus Notes email system of the Directorate. For registering
for Lotus Notes email, one may register a request with the FMS Helpdesk.

Q 2. | have some queries regarding website www.irsofficersonline.gov.in. Whom to contact in
this regard?

Ans. This website is maintained by the Database Cell of the CBDT. Any query pertaining to this
website may be addressed to concerned Officer as per the guidelines provided on this website.
Q 3. Where to get the latest press releases issued by the Income Tax Department?

Ans. Publishing of latest events/updates/Media Releases on “What's New” section of the
homepage of the website www.incometaxindia.gov.in.

Q 4. Where are the detailed guidelines pertaining to non-residents provided for the users?

Ans. Country-wise listing of all Double Taxation Avoidance Agreements is provided on this
website. Detailed legal provisions for foreign companies and Authority for Advance Ruling are
also provided.
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